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1
Product Description

The HP Pavilion dv8200 Notebook PC and HP Pavilion dv8000 
Notebook PC offer advanced modularity, AMD Mobile 
Turion™ 64 Mobile Technology and Mobile AMD Sempron™ 
processors, and extensive multimedia support.

HP Pavilion dv8200 Notebook PC and HP Pavilion dv8000 
Notebook PC
Maintenance and Service Guide 1–1



Product Description
1.1 Features
■ The following processors, varying by computer model:

❏ AMD Turion 64 ML-44 (2.4-GHz)

❏ AMD Turion 64 ML-40 (2.2-GHz)

❏ AMD Turion 64 ML-40 (2.2-GHz)

❏ AMD Turion 64 ML-37 (2.0-GHz)

❏ AMD Turion 64 ML-34 (1.8-GHz)

❏ AMD Turion 64 ML-32 (1.8-GHz)

❏ AMD Turion 64 ML-30 (1.6-GHz)

❏ Mobile AMD Sempron 3300 (2.0-GHz)

❏ Mobile AMD Sempron 3100 (1.8-GHz)

■ 17.0-inch, WSXGA+, TFT (1680 × 1050) with BrightView 
or 17.0-inch, WXGA+, TFT (1440 × 900) with BrightView 
display, varying by computer model

■ 120-, 100-, or 80-GB high-capacity hard drive, varying by 
computer model

■ 256-MB DDR1 synchronous DRAM (SDRAM) at 333 MHz, 
expandable to 2.0 GB

■ Microsoft® Windows® XP Home Edition or Windows XP 
Professional, varying by computer model

■ Full-size Windows keyboard with full-size numeric keypad

■ TouchPad pointing device, including dedicated vertical scroll 
region

■ Integrated 10Base-T/100Base-TX Ethernet local area 
network (LAN) network interface card (NIC) with RJ-45 jack

■ Integrated high-speed 56K modem with RJ-11 jack

■ Integrated wireless support for Mini PCI IEEE 802.11a/b/g 
WLAN device
1–2 Maintenance and Service Guide



Product Description
■ Support for one Type I or Type II PC Card slot, with support 
for both 32-bit (CardBus) and 16-bit PC Cards

■ Support for ExpressCard slot

■ External 65-watt AC adapter with 3-wire power cord

■ 8-cell Li-Ion battery

■ Stereo speakers

■ Volume up, volume mute, and volume down buttons

■ QuickPlay buttons

■ Support for the following optical drives:

❏ DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe

❏ DVD±RW and CD-RW Double-Layer Combo Drive

❏ DVD/CD-RW Combo Drive

■ Connectors:

❏ Audio-in (microphone)

❏ Audio-out (headphone)

❏ Digital Media Slot

❏ Expansion port 2

❏ ExpressCard slot

❏ External monitor

❏ IEEE 1394

❏ PC Card

❏ Power

❏ RJ-11 (modem)

❏ RJ-45 (network)

❏ S-Video-out

❏ Universal Serial Bus (USB) v. 2.0 (4 ports)
Maintenance and Service Guide 1–3



Product Description
1.2 Resetting the Computer
If the computer you are servicing has an unknown password, 
follow these steps to clear the password. These steps also 
clear CMOS:

1. Enter an incorrect password and press enter.

2. Repeat Step 1 two times.

After the third entry of the incorrect password, the computer 
responds with a “System Disabled” message and provides an 
override password.

3. Access MS/DOS by clicking Start > All Programs > 
Accessories > Command Prompt.

4. Enter “unlock6 xxxxx 0,” where “xxxxx” is the password 
generated by the computer in Step 2.

The computer responds with another system-generated 
password. This password can be used to reset the computer 
and clear all CMOS settings.
1–4 Maintenance and Service Guide
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1.3 Power Management
The computer comes with power management features that 
extend battery operating time and conserve power. The 
computer supports the following power management features:

■ Standby

■ Hibernation

■ Setting customization by the user

■ Hotkeys for setting the level of performance

■ Battery calibration

■ Lid switch standby/resume

■ Power button

■ Advanced Configuration and Power Management (ACPM) 
compliance
Maintenance and Service Guide 1–5
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1.4 External Components
The external components on the front of the computer are shown 
below and described in Table 1-1.

Front Components
1–6 Maintenance and Service Guide



Product Description
Table 1-1

Front Components

Item Component Function

1 Power light ■ On: Computer is turned on.

■ Off: Computer is off or in hibernation.

■ Blinking: Computer is in standby.

2 Battery light ■ On: A battery is charging or is close to 
full charge capacity.

■ Off: If the computer is plugged into an 
external power source, the light is turned 
off when all batteries in the computer are 
fully charged. If the computer is not 
plugged into an external power source, 
the light stays off until the battery 
reaches a low-battery condition.

■ Blinking: A battery that is the only 
available power source has reached a 
low-battery condition. When the battery 
reaches a critical low-battery condition, 
the battery light begins blinking quickly.

3 Drive light On or blinking: The internal hard drive or an 
optical drive is being accessed.

4 Speakers Produce stereo sound.

5 Display release latch Opens the computer.
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The external components on the right side of the computer are 
shown below and described in Table 1-2.

Right-Side Components
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Product Description
Table 1-2

Right-Side Components

Item Component Function

1 ExpressCard slot Supports an optional ExpressCard.

2 Audio-out 
(headphone) jack

Connects an optional headphone or 
powered stereo speakers. Also connects 
the audio function of an audio/video device, 
such as a television or VCR.

3 Audio-in (microphone) 
jack

Connects an optional stereo microphone.

4 USB ports (2) Connect optional USB devices.

5 Optical drive Supports an optical disc, such as a CD 
or DVD.
Maintenance and Service Guide 1–9
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The external components on the left side of the computer are 
shown below and described in Table 1-3.

Left-Side Components

Table 1-3

Left-Side Components

Item Component Function

1 Power connector Connects the AC adapter cable.

2 Monitor port Connects an optional VGA monitor or 
projector.

3 S-Video-out jack Connects the video function of an optional 
S-Video device, such as a television, VCR, 
or video capture card.

4 RJ-45 (network) jack Connects a network cable (not included).
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5 Expansion port 2 Connects the computer to an optional 
docking device.

✎ The computer has only one 
expansion port. The term expansion 
port 2 describes the type of 
expansion port.

6 USB ports (2) Connect optional USB devices.

7 1394 port (4-pin) Connects an optional 1394a device such as 
a scanner, a digital camera, or a digital 
camcorder.

8 Digital Media Slot light On: An optional digital card is being 
accessed.

9 Digital Media Slot Supports the following optional digital 
cards: SD (Secure Digital) Memory Card, 
SD I/O Card, Memory Stick, Memory Stick 
Pro, MultiMediaCard, xD-Picture Card, and 
SmartMedia.

10 PC Card slot Supports an optional Type I or Type II 
32-bit (CardBus) or 16-bit PC Card.

11 PC Card eject button Ejects PC Cards from the PC Card slot.

Table 1-3

Left-Side Components (Continued)

Item Component Function
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The external components on the rear panel of the computer are 
shown below and described in Table 1-4.

Rear Panel Components
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Table 1-4

Rear Panel Components

Item Component Function

1 Security cable slot Attaches an optional security cable to the 
computer.

✎ The purpose of security solutions is 
to act as a deterrent. These solutions 
do not prevent the product from 
being mishandled or stolen.

2 RJ-11 (modem) jack Connects a modem cable (not included).

3 Battery bay Holds a battery.

4 Wireless light On: One or more internal wireless devices 
have been turned on.

✎ To establish a wireless connection, a 
wireless network must already be set 
up.

5 Vent Provides airflow to cool internal 
components.

Ä To prevent overheating, do not 
obstruct vents. Do not allow a hard 
surface, such as a printer, or a soft 
surface, such as pillows or thick rugs 
or clothing, to block airflow.
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The standard keyboard components of the computer are shown 
below and described in Table 1-5.

Standard Keyboard Components
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Table 1-5

Standard Keyboard Components

Item Component Function

1 f1 to f12 keys (12) Perform system and application tasks. 
When combined with fn, function keys 
perform additional tasks as hotkeys.

2 caps lock key Enables caps lock and turns on the caps 
lock light.

3 fn key Combines with other keys to perform 
system tasks as hotkeys. For example, 
pressing fn+f7 decreases screen 
brightness.

4 Windows logo key Displays the Microsoft Windows Start 
menu.

5 Windows 
applications key

Displays a shortcut menu for items 
beneath the pointer.

6 Arrow keys Move the cursor around the screen.

7  Numeric keypad keys 
(16)

Can be used like the keys on an external 
numeric keypad.

8 num lock key Enables numeric lock, turns on the 
embedded numeric keypad, and turns 
on the num lock light.
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The computer top components are shown below and described in 
Table 1-6.

Top Components

Table 1-6

Top Components

Item Component Function

1 Display switch Initiates standby if the display is closed 
when the computer is on.

2 Wireless light On: One or more internal wireless devices 
have been turned on.

✎ To establish a wireless connection, 
a wireless network must already be 
set up.
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3 Wireless button Turns the wireless functionality on or off, 
but does not create a wireless connection.

✎ To establish a wireless connection, 
a wireless network must already be 
set up.

4 Power light ■ On: The computer is on.

■ Blinking: The computer is in standby.

■ Off: The computer is off or in 
hibernation.

Power button When the computer is

■ Off, press to turn on the computer.

■ On, press to enter hibernation.

■ In standby, briefly press to exit standby.

■ In hibernation, briefly press to exit 
hibernation.

If the computer has stopped responding 
and Microsoft® Windows® shutdown 
procedures cannot be used, press and 
hold the power button for at least 
5 seconds to turn off the computer.

5 Volume down button Decreases system volume.

6 Volume mute button Mutes or restores volume.

7 Volume up button Increases system volume.

Table 1-6

Top Components (Continued)

Item Component Function
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The Quick Play and Quick Launch buttons are shown below and 
described in Table 1-7.

Top Components
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Table 1-7

QuickPlay and Quick Launch Button Components

Item Component Function

1 DVD button Default button functions without QuickPlay 
software:
When the computer is

■ On: Opens the default DVD application 
to start a DVD in the optical drive.

■ Off: No function.

■ In standby: Resumes from standby into 
Windows.

■ In hibernation: Restores from 
hibernation into Windows.

Button functions with QuickPlay software:
When the computer is

■ On: Opens the default DVD application 
to start a DVD in the optical drive.

■ Off: Opens QuickPlay to start a DVD in 
the optical drive.

■ In standby: Resumes from standby into 
Windows.

■ In hibernation: Restores from 
hibernation into Windows.
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2 Media Button Default button functions without QuickPlay 
software:
When the computer is

■ On: Opens the music application or 
the Media menu, allowing you to select 
a multimedia application.

■ Off: No function.

■ In standby: Resumes from standby into 
Windows.

■ In hibernation: Restores from 
hibernation into Windows.

Button functions with QuickPlay software:
When the computer is

■ On: Opens the music application or 
the Media menu, allowing you to select 
a multimedia application.

■ Off: Opens the music application or 
the Media menu, allowing you to select 
a multimedia application.

■ In standby: Resumes from standby into 
Windows.

■ In hibernation: Restores from 
hibernation into Windows.

3 Quick Launch 
calculator button

Opens the Microsoft Windows calculator.
This button can also be reassigned to an 
Internet or network destination or to any 
software application or data file.

✎ When you press the Quick Launch 
calculator button, num lock is 
enabled.

Table 1-7

QuickPlay and Quick Launch Button Components (Continued)

Item Component Function
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The computer TouchPad components are shown below and 
described in Table 1-8.

TouchPad Components

Table 1-8

TouchPad Components

Item Component Function

1 Left and right 
TouchPad buttons

Function like the left and right buttons on 
an external mouse.

2 TouchPad Moves the pointer and selects or activates 
items on the screen. Can be set to perform 
other mouse functions, such as scrolling, 
selecting, and double-clicking.

3 TouchPad vertical 
scroll zone

Scrolls up or down.
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The external components on the bottom of the computer are 
shown below and described in Table 1-9.

Bottom Components

Table 1-9

Bottom Components

Item Component Function

1 Optical drive Supports an optical disc, such as a 
CD or DVD.

2 Labels area Contains the serial number and other 
information labels.

3 Battery release latch Releases a battery from the battery bay.

4 Battery bay Holds a battery.
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5 Vents (2) Provide airflow to cool internal 
components.

Ä To prevent overheating, do not 
obstruct vents. Do not allow a 
hard surface, such as a printer, or 
a soft surface, such as pillows 
or thick rugs or clothing, to block 
airflow.

6 Memory/Mini PCI module 
compartment cover

■ Contains 2 memory module slots that 
support replaceable memory 
modules. The number of preinstalled 
memory modules varies by computer 
model.

■ Holds an optional wireless LAN 
device (select models only).

Ä To prevent an unresponsive 
system and the display of a 
warning message, install only a 
Mini PCI device authorized for 
use in your computer by the 
governmental agency that 
regulates wireless devices in 
your country. If you install an 
unauthorized device and then 
receive a warning message, 
remove the device to restore 
computer functionality. Then 
contact Customer Care.

7 Hard drive bay Holds the internal hard drive.

Table 1-9

Bottom Components (Continued)

Item Component Function
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1.5 Design Overview
This section presents a design overview of key parts and features 
of the computer. Refer to Chapter 3, “Illustrated Parts Catalog,” 
to identify replacement parts, and Chapter 5, “Removal and 
Replacement Procedures,” for disassembly steps.

The system board provides the following device connections:

■ AMD Turion 64 processors

■ AMD Mobile Sempron processors

■ Audio

■ Digital media card

■ Display

■ ExpressCard

■ Hard drive

■ Keyboard

■ Memory module

■ Mini Card devices

■ Mini PCI communications devices

■ PC Card

■ TouchPad

Ä
CAUTION: To properly ventilate the computer, allow at least a 7.6-cm 
(3-inch) clearance on the left and right sides of the computer.

The computer uses an electric fan for ventilation. The fan is 
controlled by a temperature sensor and is designed to turn on 
automatically when high temperature conditions exist. These 
conditions are affected by high external temperatures, system 
power consumption, power management/battery conservation 
configurations, battery fast charging, and software. Exhaust air is 
displaced through the ventilation grill located on the left side of 
the computer.
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2
Troubleshooting

Å
WARNING: Only authorized technicians trained by HP should repair 
this equipment. All troubleshooting and repair procedures are detailed 
to allow only subassembly-/module-level repair. Because of the 
complexity of the individual boards and subassemblies, do not attempt 
to make repairs at the component level or modifications to any printed 
wiring board. Improper repairs can create a safety hazard. Any 
indication of component replacement or printed wiring board 
modification may void any warranty or exchange allowances.

2.1 Computer Setup
Computer Setup is a system information and customization utility 
that can be used even when the operating system is not working 
or will not load. This utility includes settings that are not 
available in Windows.

Using Computer Setup

Information and settings in Computer Setup are accessed from 
the File, Security, Diagnostics, or System Configuration menus:

1. Turn on or restart the computer. Press f10 while the 
F10 = ROM-Based Setup message is displayed in 
the lower-left corner of the screen.

❏ To change the language, use the cursor control keys 
to navigate to the System Configuration menu.

❏ To view navigation information, press f1.

❏ To return to the Computer Setup menu, press esc.
Maintenance and Service Guide 2–1
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2. Select the File, Security, Diagnostics, or 
System Configuration menu.

3. To close Computer Setup and restart the computer:

❏ Select File > Save changes and exit, and then press enter.

– or –

❏ Select File > Ignore changes and exit, and then 
press enter.

– or –

❏ Select File > Restore defaults, and then press enter.

4. When you are prompted to confirm your action, press f10.

Selecting from the File Menu

Table 2-1

File Menu

Select To Do This

System Information ■ View identification information about the 
computer, processor, memory and cache size, 
and system ROM.

■ View BIOS revision, keyboard controller 
version, and battery pack serial number 
information.
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Selecting from the Security Menu

Table 2-2

Security Menu

Select To Do This

Setup Password Enter, change, or delete an Setup password.

Power-On Password Enter, change, or delete a power-on password.

Password Options
(Password options can 
be selected only when 
a power-on password 
has been set.)

Enable/disable:

■ Stringent security.

■ Requirement of password on restart.

DriveLock Passwords Enable/disable DriveLock; change a DriveLock 
user or master password.

✎ DriveLock Settings are accessible only 
when you enter Computer Setup by turning 
on (not restarting) the computer.

Smart Card Security Enable/disable smart card power-on support.

✎ A setup password must be established to 
use this feature.

TPM Embedded Security Enable/disable:

■ Embedded security device state.

■ Power-on authentication support.

■ Automatic DriveLock support.

System IDs Establish:

■ Notebook asset tracking number.

■ Notebook ownership tags.

Disk Sanitizer Establish fast, optimum, or custom settings for 
disk sanitizing.

*Not applicable to SuperDisk LS-120 drives.
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Selecting from the Diagnostics Menu

Table 2-3

Diagnostics Menu

Select To Do This

HDD Self-Test Options Run a quick comprehensive self test on hard 
drives in the system that support the test features.

Memory Check Run a quick comprehensive test on system 
memory on the following categories:

■ Walking 0s

■ Walking 1s

■ High Address line testing

■ Alternate Pattern testing
2–4 Maintenance and Service Guide
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Selecting from the System Configuration 
Menu

Table 2-4

System Configuration Menu

Select To Do This

Language Change the Computer Setup language.

Boot Options Enable/disable MultiBoot, which sets a startup 
sequence that can include most bootable devices 
and media in the system.

Device Configurations Enable/disable:

■ Swap Fn/Ctrl keys.

■ USB legacy support.

■ BIOS DMA data transfers.

■ Fan Always on while on AC Power.

■ Data Execution Prevention.

■ LAN Power save.

Built-In Device Options Enable/disable:

■ Embedded WLAN Device Radio.

■ Embedded Bluetooth Device Radio.

■ LAN/WLAN Switching.

■ Wake on LAN from Off.

Port Options Enable/disable:

■ USB Port.

■ 1394 Port.

■ CardBus Slot.
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2.2 Troubleshooting Flowcharts

Table 2-5

Troubleshooting Flowcharts Overview

Flowchart Description

2.1 “Flowchart 2.1—Initial Troubleshooting”

2.2 “Flowchart 2.2—No Power, Part 1”

2.3 “Flowchart 2.3—No Power, Part 2”

2.4 “Flowchart 2.4—No Power, Part 3”

2.5 “Flowchart 2.5—No Power, Part 4”

2.6 “Flowchart 2.6—No Video, Part 1”

2.7 “Flowchart 2.7—No Video, Part 2”

2.8 “Flowchart 2.8—Nonfunctioning Docking Device (if applicable)”

2.9 “Flowchart 2.9—No Operating System (OS) Loading”
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Troubleshooting
Flowchart 2.1—Initial Troubleshooting
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Troubleshooting
Flowchart 2.2—No Power, Part 1
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Troubleshooting
Flowchart 2.3—No Power, Part 2
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Troubleshooting
Flowchart 2.4—No Power, Part 3
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Flowchart 2.5—No Power, Part 4
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Flowchart 2.6—No Video, Part 1
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Flowchart 2.7—No Video, Part 2
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Flowchart 2.8—Nonfunctioning Docking Device
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Troubleshooting
Flowchart 2.9—No Operating System (OS) 
Loading
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Troubleshooting
Flowchart 2.10—No OS Loading, Hard Drive, 
Part 1
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Flowchart 2.11—No OS Loading, Hard Drive, 
Part 2
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Flowchart 2.12—No OS Loading, Hard Drive, 
Part 3
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Flowchart 2.13—No OS Loading, Diskette Drive
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Flowchart 2.14—No OS Loading, Optical Drive
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Flowchart 2.15—No Audio, Part 1
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Flowchart 2.16—No Audio, Part 2
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Flowchart 2.17—Nonfunctioning Device
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Flowchart 2.18—Nonfunctioning Keyboard
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Flowchart 2.19—Nonfunctioning Pointing 
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Troubleshooting
Flowchart 2.20—No Network/Modem 
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3
Illustrated Parts Catalog

This chapter provides an illustrated parts breakdown and a 
reference for spare part numbers.

3.1 Serial Number Location
When ordering parts or requesting information, provide the 
computer serial number and model number located on the bottom 
of the computer.

Serial Number Location
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3.2 Computer Major Components

Computer Major Components
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components

Item Description
Spare Part 
Number

1 Display assemblies (include display cable, wireless antenna boards, 
and antenna cables)

17-inch, WSXGA+, TFT, single-lamp with BrightView
17-inch, WXGA+, TFT, single-lamp with BrightView

403797-001
403796-001

✎ Refer to Section 3.3, “Display Assembly Subcomponents,” for 
display assembly internal component spare part number 
information.

2 Switch cover (includes LED board and 
LED board cable)

403817-001

3 Keyboard assembly frame 403818-001

4 LED boards (include LED board cable)

For use with HP Pavilion dv8200 models
For use with HP Pavilion dv8000 models

417033-001
403833-001

5 Keyboards

France
French Canada
Germany
Italy
Norway

403809-051
403809-121
403809-041
403809-061
403809-091

Spain
Sweden and 
Finland
United Kingdom
United States

403809-071
403809-101

403809-031
403809-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

6 Top cover (includes TouchPad) 403822-001

7
Bracket Kit, includes:
Display hinge support bracket
Not illustrated:
Optical drive bracket (also included with optical drive 
spare part kits)
Hard drive bracket (also included with hard drive spare 
part kits)
Expansion port 2 bracket
TouchPad bracket (also included with top cover spare 
part kits)

403816-001

8 Speakers 403825-001

9 System boards

For use with HP Pavilion dv8200 models
For use with HP Pavilion dv8000 models

417029-001
403790-001

10 Optical drives

DVD±RW and CD-RW Double-Layer Combo Drive 
with LightScribe
DVD±RW and CD-RW Double-Layer Combo Drive
DVD/CD-RW Combo Drive

403807-001

403806-001
403805-001

DVD±RW and CD-RW Double-Layer Combo Drive 
with LightScribe and Hitachi-LG Data Storage
DVD±RW and CD-RW Double-Layer Combo Drive 
with Hitachi-LG Data Storage
DVD/CD-RW Combo Drive with Hitachi-LG Data 
Storage

417621-001

417620-001

417619-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

10 Optical drives (Continued)

DVD±RW and CD-RW Super Multi Double-Layer 
Combo Drive with LightScribe
DVD±RW and CD-RW Super Multi Combo Drive with 
LightScribe
DVD±RW and CD-RW Super Multi Double-Layer 
Combo Drive

430862-001

430186-001

430861-001

11 Heat sink (includes thermal paste) 403827-001

12 USB boards (include USB board and USB board cable)

For use with HP Pavilion dv8200 models
For use with HP Pavilion dv8000 models

417032-001
403830-001

13 Optical drive connector boards

For use with HP Pavilion dv8200 models
For use with HP Pavilion dv8000 models

417031-001
403829-001

14 Fan assembly 403826-001

15 Processors (include thermal paste)

AMD Turion 64 ML-44 (2.4-GHz)
AMD Turion 64 ML-40 (2.2-GHz)
AMD Turion 64 ML-40 (2.2-GHz)
AMD Turion 64 ML-37 (2.0-GHz)
AMD Turion 64 ML-34 (1.8-GHz)
AMD Turion 64 ML-32 (1.8-GHz)
AMD Turion 64 ML-30 (1.6-GHz)

410324-001
430499-001
393579-001
393578-001
417030-001
395744-001
395743-001

Mobile AMD Sempron 3300 (2.0-GHz)
Mobile AMD Sempron 3100 (1.8-GHz)

430860-001
430855-001

16 ExpressCard assembly 403828-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

Plastics Kit 403812-001

17a
17b
17c
17d

17e

Includes:
ExpressCard slot bezel
PC Card slot bezel
Memory shield
Hard drive cover for use only with HP Pavilion dv8000 models 
(includes 3 captive screws, secured by C clips)
Memory/Mini PCI module compartment cover (includes 2 captive 
screws, secured by C clips)
Computer feet (not illustrated)

18 RTC battery 403819-001

19 Bluetooth® module (includes Bluetooth module cable) 397922-001

20 PC Card assembly 403835-001

21 Base enclosure 403824-001

22 Hard drives (include frame and connector)

For use with HP Pavilion dv8200 models

7200 rpm, 100-GB
5400 rpm, 80-GB

418579-001
418576-001

4200-rpm, 120-GB
4200-rpm, 100-GB
4200-rpm, 60-GB

418580-001
418577-001
418578-001

Hard drive cover for use with HP Pavilion dv8200 
models

419327-001

For use with HP Pavilion dv8000 models

7200 rpm, 100-GB
5400 rpm, 80-GB

405938-001
403803-001

4200-rpm, 120-GB
4200-rpm, 100-GB
4200-rpm, 60-GB

405939-001
403804-001
405937-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

23 8-cell, 4.4-hour battery 403808-001

24 Mini PCI communications modules

802.11a/b/g wireless local access network (WLAN) 
module for use in North America
802.11a/b/g WLAN module for use in the rest of the 
world

403791-001

403792-001

802.11b/g WLAN module for use in North America
802.11b/g WLAN module for use in the rest of the world

392557-001
392557-002

25 Memory modules

1024 MB
512 MB
256 MB

403800-001
403799-001
407843-001

Secure Digital (SD) memory cards (not illustrated)

512 MB
256-MB

407316-001
403573-001
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3.3 Display Assembly Subcomponents

Table 3-2

Display Assembly Subcomponent

Spare Part Number Information

Item Description

1a
1b

Display Plastics Kits
For use with dual-lamp displays
For use with single-lamp displays
Includes:

■ Display bezel

■ Display enclosure

■ Display release latch actuator and hooks 
(not illustrated)

412269-001
403881-001

2 Display Hinge Kits
For use with dual-lamp displays
For use with single-lamp displays

412270-001
403884-001
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3 Display inverter boards
For use with dual-lamp displays
For use with single-lamp displays

412268-001
403831-001

4 Display Panel Kits (include display panel cable)
17-inch, WSXGA+ with BrightView and dual-lamp
17-inch, WSXGA+ with BrightView
17-inch, WXGA+ with BrightView

tbd-001
417617-001
417616-001

5 Wireless Antenna Kit (includes cable and 
transceivers)

403882-001

Display Cable Kits (not illustrated)
For use with dual-lamp displays
For use with single-lamp displays

412271-001
403885-001

Display Label Kit (not illustrated) 403887-001

Display Screw Kit (not illustrated), includes:

■ Phillips PM2.5×7.0 screws

■ Phillips PM2.5×5.0 screws

■ Rubber screw covers

403886-001

Pad Kit (not illustrated), includes rubber screw covers 403815-001

Table 3-2

Display Assembly Subcomponent

Spare Part Number Information (Continued)

Item Description
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3.4 Plastics Kit

Table 3-3

Plastics Kit

Spare Part Number Information

Item Description
Spare Part 
Number

Plastics Kit
Includes:

403812-001

1 Memory/Mini PCI module compartment cover (includes 2 captive 
screws, secured by C-clips)

2 Hard drive cover (includes 3 captive screws, secured by C-clips)

3 Computer feet (6)

4 ExpressCard slot bezel

5 PC Card slot bezel
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3.5 Cable Kit

Table 3-4

Cable Kit

Spare Part Number Information

Item Description
Spare Part 
Number

Cable Kit
Includes:

403814-001

1 TouchPad cable

2 Modem connector cable

3 Bluetooth module cable

4 USB board cable

5 Power connector cable
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3.6 Mass Storage Devices

Table 3-5

Mass Storage Devices

Spare Part Number Information

Item Description
Spare Part 
Number

1 Hard drives (include frame and connector)

For use with HP Pavilion dv8200 models

7200 rpm, 100-GB
5400 rpm, 80-GB

418579-001
418576-001

4200-rpm, 120-GB
4200-rpm, 100-GB
4200-rpm, 60-GB

418580-001
418577-001
418578-001

For use with HP Pavilion dv8000 models

7200 rpm, 100-GB
5400 rpm, 80-GB

405938-001
403803-001

4200-rpm, 120-GB
4200-rpm, 100-GB
4200-rpm, 60-GB

405939-001
403804-001
405937-001
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2 Optical drives

DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe
DVD±RW and CD-RW Double-Layer Combo Drive
DVD/CD-RW Combo Drive

403807-001

403806-001
403805-001

DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe and Hitachi-LG Data Storage
DVD±RW and CD-RW Double-Layer Combo Drive with 
Hitachi-LG Data Storage
DVD/CD-RW Combo Drive and Hitachi-LG Data 
Storage

417621-001

417620-001

417619-001

DVD±RW and CD-RW Super Multi Double-Layer 
Combo Drive with LightScribe
DVD±RW and CD-RW Super Multi Combo Drive with 
LightScribe
DVD±RW and CD-RW Super Multi Double-Layer 
Combo Drive

430862-001

430186-001

430861-001

USB digital drive (not illustrated) 364727-001

Table 3-5

Mass Storage Devices

Spare Part Number Information

Item Description
Spare Part 
Number
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3.7 Miscellaneous (Not Illustrated)

Table 3-6

Miscellaneous (Not Illustrated)

Spare Part Information

Description
Spare Part 
Number

All-in-one media cable 375759-001

Analog TV tuner 407941-001

Audio Y-cable 2 379452-001

Composite S-Video and audio cable 407939-001

DVB-T TV tuner 412175-001

DVB-T TV tuner antenna 412176-001

DVB-T TV tuner antenna adapter 412177-001

HP remote control II 396975-001

Infrared blaster cable 408484-001

Infrared USB receiver 408483-001

Power connectors

90-watt 410323-001

65-watt 410322-001

Power cords

For use in:

Canada, French Canada, and the United States 403811-001

France, Germany, and Spain 403811-021

The United Kingdom 403811-031

Italy 403811-061
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Power supplies

65 watt 403810-001

90 watt non-PFC 408487-001

90 watt PFC 408488-001

Remote TV tuner 408479-001

RF cable 408485-001

RF input adapter cable 407940-001

Screw Kit (includes the following screws; refer to
Appendix A, “Screw Listing,” for more information on 
specifications and usage)

403813-001

■ Phillips PM3.0×4.0 screw

■ Phillips PM2.5×13.0 screw

■ Phillips PM2.5×9.0 screw

■ Phillips PM2.5×7.0 screw

■ Black Phillips PM2.5×6.0 screw

■ Silver Phillips PM2.5×6.0 screw

■ Phillips PM2.5×4.0 screw

■ Phillips PM2.0×4.0 screw

■ Slotted M1.5×9.0 screw

TV tuner remote control 408479-001

USB travel mouse 309674-001

USB digital drive 364727-001

Wired headset with volume control 371693-001

Table 3-6

Miscellaneous (Not Illustrated)

Spare Part Information (Continued)

Description
Spare Part 
Number
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3.8 Sequential Part Number Listing

Table 3-7

Sequential Part Number Listing

Spare Part 
Number Description

309674-001 USB travel mouse

364727-001 USB digital drive

371693-001 Wired headset with volume control

375759-001 All-in-one media cable

379452-001 Audio Y-cable 2

392557-001 802.11b/g WLAN Mini PCI communications module for use in 
North America

392557-002 802.11b/g WLAN Mini PCI communications module for use in 
the rest of the world

393578-001 AMD Turion 64 ML-37 (2.0-GHz) processor (includes 
thermal paste)

393579-001 AMD Turion 64 ML-40 (2.2-GHz) processor (includes 
thermal paste)

395743-001 AMD Turion 64 ML-30 (1.6-GHz) processor (includes 
thermal paste)

395744-001 AMD Turion 64 ML-32 (1.8-GHz) processor (includes 
thermal paste)

396975-001 HP remote control II

397922-001 Bluetooth wireless module (includes Bluetooth module cable)

403573-001 256-MB SD memory card

403790-001 System board for use with HP Pavilion dv8000 models

403791-001 802.11a/b/g WLAN Mini PCI communications module for use 
in North America
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403792-001 802.11a/b/g WLAN Mini PCI communications module for use 
in the rest of the world

403796-001 17-inch, WXGA+, TFT, single-lamp display assembly with 
BrightView (includes display cable, wireless antenna boards, 
and antenna cables)

403797-001 17-inch, WSXGA+, TFT, single-lamp display assembly with 
BrightView (includes display cable, wireless antenna boards, 
and antenna cables)

403799-001 512-MB memory module

403800-001 1024-MB memory module

403803-001 5400 rpm, 80-GB hard drive for use with HP Pavilion dv8000 
models (includes frame and connector)

403804-001 4200-rpm, 100-GB hard drive for use with HP Pavilion dv8000 
models (includes frame and connector)

403805-001 DVD/CD-RW Combo Drive

403806-001 DVD±RW and CD-RW Double-Layer Combo Drive

403807-001 DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe

403808-001 8-cell, 4.4-hour battery

403809-001 Keyboard for use in the United States

403809-031 Keyboard for use in the United Kingdom

403809-041 Keyboard for use in Germany

403809-051 Keyboard for use in France

403809-061 Keyboard for use in Italy

403809-071 Keyboard for use in Spain

403809-091 Keyboard for use in Norway

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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403809-101 Keyboard for use in Sweden and Finland

403809-121 Keyboard for use in French Canada

403810-001 Power supply, 65 watt

403811-001 Power cord for use in the United States

403811-021 Power cord for use Internationally

403811-031 Power cord for use in the United Kingdom

403811-061 Power cord for use in Italy

403812-001 Plastics Kit

403813-001 Screw Kit

403814-001 Cable Kit

403815-001 Pad Kit

403816-001 Bracket Kit

403817-001 Switch cover (includes LED board and LED board cable)

403818-001 Keyboard assembly frame

403819-001 RTC battery

403822-001 Top cover (includes TouchPad)

403824-001 Base enclosure

403825-001 Speakers

403826-001 Fan assembly

403827-001 Heat sink (includes thermal paste)

403828-001 ExpressCard assembly

403829-002 Optical drive connector board for use with HP Pavilion dv8000 
models

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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403830-001 USB board for use with HP Pavilion dv8000 models (includes 
USB board and USB board cable)

403831-001 Display inverter board for use with single-lamp displays

403833-001 LED board for use with HP Pavilion dv8000 models (includes 
LED board cable)

403835-001 PC Card assembly

403881-001 Display Plastics Kit for use with single-lamp displays

403882-001 Wireless Antenna Kit (includes cable and transceivers)

403884-001 Display Hinge Kit for use with single-lamp displays

403885-001 Display Cable Kit for use with single-lamp displays

403886-001 Display Screw Kit

403887-001 Display Label Kit 

405937-001 4200-rpm, 60-GB hard drive for use with HP Pavilion dv8000 
models (includes frame and connector)

405938-001 7200 rpm, 100-GB hard drive for use with HP Pavilion dv8000 
models (includes frame and connector)

405939-001 4200-rpm, 120-GB hard drive for use with HP Pavilion dv8000 
models (includes frame and connector)

407316-001 512-MB SD memory card

407843-001 256-MB memory module

407939-001 Composite S-Video and audio cable

407940-001 RF input adapter cable

407941-001 Analog TV tuner

408479-001 TV tuner remote control

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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408484-001 Infrared blaster cable

408485-001 RF cable

408483-001 Infrared USB receiver

408487-001 90-watt non-PFC AC adapter

408488-001 90-watt PFC AC adapter

410321-001 90-watt non-PFC AC adapter

410322-001 65-watt power connector

410323-001 90-watt power connector

410324-001 AMD Turion 64 ML-44 (2.4-GHz) processor (includes 
thermal paste)

412175-001 DVB-T TV tuner

412176-001 DVB-T TV tuner antenna

412177-001 DVB-T TV tuner antenna adapter

412267-001 90-watt PFC AC adapter

412268-001 Display inverter board for use with dual-lamp displays

412269-001 Display Plastics Kit for use with dual-lamp displays

412270-001 Display Hinge Kit for use with dual-lamp displays

412271-001 Display Cable Kit for use with dual-lamp displays

417029-001 System board for use with HP Pavilion dv8200 models

417030-001 AMD Turion 64 ML-34 (1.8-GHz) processor (includes 
thermal paste)

417031-001 Optical drive connector board for use with HP Pavilion dv8200 
models

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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417032-001 USB board for use with HP Pavilion dv8200 models (includes 
USB board and USB board cable)

417033-001 LED board for use with HP Pavilion dv8000 models (includes 
LED board cable)

417616-001 Display Panel Kit for use with 17-inch, WXGA+ displays with 
BrightView (include display panel cable)

417617-001 Display Panel Kit for use with 17-inch, WSXGA+ displays with 
BrightView (includes display panel cable)

417619-001 DVD/CD-RW Combo Drive with Hitachi-LG Data Storage

417620-001 DVD±RW and CD-RW Double-Layer Combo Drive with 
Hitachi-LG Data Storage

417621-001 DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe and Hitachi-LG Data Storage

418576-001 5400-rpm, 80-GB hard drive for use with HP Pavilion dv8200 
models (includes frame and connector)

418577-001 4200 rpm, 100-GB hard drive for use with HP Pavilion dv8200 
models (includes frame and connector)

418578-001 4200-rpm, 60-GB hard drive for use with HP Pavilion dv8200 
models (includes frame and connector)

418579-001 7200 rpm, 100-GB hard drive for use with HP Pavilion dv8200 
models (includes frame and connector)

418580-001 4200-rpm, 120-GB hard drive for use with HP Pavilion dv8200 
models (includes frame and connector)

418580-001 4200-rpm, 120-GB hard drive for use with HP Pavilion dv8200 
models (includes frame and connector)

419327-001 Hard drive cover for use with HP Pavilion dv8200 models

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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430499-001 AMD Turion 64 ML-40 (2.2-GHz) processor (includes 
thermal paste)

430855-001 Mobile AMD Sempron 3100 (1.8-GHz) processor (includes 
thermal paste)

430860-001 Mobile AMD Sempron 3300 (2.2-GHz) processor (includes 
thermal paste)

430861-001 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

430862-001 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 
with LightScribe

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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4
Removal and Replacement

Preliminaries

This chapter provides essential information for proper and 
safe removal and replacement service.

4.1 Tools Required
You will need the following tools to complete the removal and 
replacement procedures:
■ Magnetic screwdriver
■ Phillips P0 screwdriver
■ Flat-bladed screwdriver
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4.2 Service Considerations
The following sections include some of the considerations 
that you should keep in mind during disassembly and assembly 
procedures.

✎ As you remove each subassembly from the computer, place 
the subassembly (and all accompanying screws) away from 
the work area to prevent damage.

Plastic Parts

Using excessive force during disassembly and reassembly can 
damage plastic parts. Use care when handling the plastic parts. 
Apply pressure only at the points designated in the maintenance 
instructions.

Cables and Connectors

Ä
CAUTION: When servicing the computer, ensure that cables are 
placed in their proper locations during the reassembly process. 
Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. 
Apply only the tension required to unseat or seat the cables 
during removal and insertion. Handle cables by the connector 
whenever possible. In all cases, avoid bending, twisting, or 
tearing cables. Ensure that cables are routed in such a way 
that they cannot be caught or snagged by parts being removed 
or replaced. Handle flex cables with extreme care; these cables 
tear easily.
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4.3 Preventing Damage to 
Removable Drives
Removable drives are fragile components that must be handled 
with care. To prevent damage to the computer, damage to a 
removable drive, or loss of information, observe the following 
precautions:
■ Before removing or inserting a hard drive, shut down the 

computer. If you are unsure whether the computer is off or 
in hibernation, turn the computer on, and then shut it down 
through the operating system.

■ Before removing a diskette drive or optical drive, ensure that 
a diskette or disc is not in the drive and ensure that the optical 
drive tray is closed.

■ Before handling a drive, ensure that you are discharged of 
static electricity. While handling a drive, avoid touching the 
connector.

■ Handle drives on surfaces covered with at least one inch of 
shock-proof foam.

■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, an optical drive, or a diskette 

drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic 

fields, such as monitors or speakers.
■ Avoid exposing a drive to temperature extremes or liquids.
■ If a drive must be mailed, place the drive in a bubble pack 

mailer or other suitable form of protective packaging and label 
the package “FRAGILE: Handle With Care.”
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4.4 Preventing Electrostatic Damage
Many electronic components are sensitive to electrostatic 
discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits 
provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt 
silicon junctions.

A sudden discharge of static electricity from a finger or other 
conductor can destroy static-sensitive devices or microcircuitry. 
Often the spark is neither felt nor heard, but damage occurs.

An electronic device exposed to electrostatic discharge may not 
be affected at all and can work perfectly throughout a normal 
cycle. Or the device may function normally for a while, then 
degrade in the internal layers, reducing its life expectancy.
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4.5 Packaging and Transporting 
Precautions
Use the following grounding precautions when packaging and 
transporting equipment:
■ To avoid hand contact, transport products in static-safe 

containers, such as tubes, bags, or boxes.
■ Protect all electrostatic-sensitive parts and assemblies with 

conductive or approved containers or packaging.
■ Keep electrostatic-sensitive parts in their containers until 

the parts arrive at static-free workstations.
■ Place items on a grounded surface before removing items 

from their containers.
■ Always be properly grounded when touching a sensitive 

component or assembly.
■ Store reusable electrostatic-sensitive parts from assemblies 

in protective packaging or nonconductive foam.
■ Use transporters and conveyors made of antistatic belts and 

roller bushings. Ensure that mechanized equipment used for 
moving materials is wired to ground and that proper materials 
are selected to avoid static charging. When grounding is not 
possible, use an ionizer to dissipate electric charges.
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4.6 Workstation Precautions
Use the following grounding precautions at workstations:
■ Cover the workstation with approved static-shielding material 

(refer to Table 4-2, “Static-Shielding Materials”).
■ Use a wrist strap connected to a properly grounded work 

surface and use properly grounded tools and equipment.
■ Use conductive field service tools such as cutters, 

screwdrivers, and vacuums.
■ When fixtures must directly contact dissipative surfaces, use 

fixtures made only of static-safe materials.
■ Keep the work area free of nonconductive materials such 

as ordinary plastic assembly aids and Styrofoam.
■ Handle electrostatic-sensitive components, parts, and 

assemblies by the case or PCM laminate. Handle these 
items only at static-free workstations.

■ Avoid contact with pins, leads, or circuitry.
■ Turn off power and input signals before inserting or removing 

connectors or test equipment.
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4.7 Grounding Equipment and 
Methods
Grounding equipment must include either a wrist strap or a 
foot strap at a grounded workstation.
■ When seated, wear a wrist strap connected to a grounded 

system. Wrist straps are flexible straps with a minimum of 
one megohm ±10% resistance in the ground cords. To provide 
proper ground, wear a strap snugly against the skin at all times. 
On grounded mats with banana-plug connectors, use alligator 
clips to connect a wrist strap.

■ When standing, use foot straps and a grounded floor mat. 
Foot straps (heel, toe, or boot straps) can be used at standing 
workstations and are compatible with most types of shoes 
or boots. On conductive floors or dissipative floor mats, use 
foot straps on both feet with a minimum of one megohm 
resistance between the operator and ground. To be effective, 
the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing 
electrostatic damage includes:
■ Antistatic tape
■ Antistatic smocks, aprons, and sleeve protectors
■ Conductive bins and other assembly or soldering aids
■ Nonconductive foam
■ Conductive tabletop workstations with ground cords of 

one megohm resistance
■ Static-dissipative tables or floor mats with hard ties to 

the ground
■ Field service kits
■ Static awareness labels
■ Material-handling packages
■ Nonconductive plastic bags, tubes, or boxes
■ Metal tote boxes
■ Electrostatic voltage levels and protective materials
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Table 4-1 shows how humidity affects the electrostatic voltage 
levels generated by different activities.

Table 4-2 lists the shielding protection provided by antistatic 
bags and floor mats.

Table 4-1

Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V  5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

✎ A product can be degraded by as little as 700 V.

Table 4-2

Static-Shielding Materials

Material Use Voltage Protection Level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Removal and Replacement

Procedures

This chapter provides removal and replacement procedures.

There are as many 113 screws, in 9 different sizes and types, that 
may have to be removed, replaced, or loosened when servicing 
the computer. Make special note of each screw size and location 
during removal and replacement.

Refer to Appendix A, “Screw Listing,” for detailed information on 
screw and nut sizes, locations, and usage.
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5.1 Serial Number
Report the computer serial number to HP when requesting 
information or ordering spare parts. The serial number is 
located on the bottom of the computer.

Serial Number Location
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5.2 Disassembly Sequence Chart
Use the chart below to determine the section number to be 
referenced when removing computer components.

Disassembly Sequence Chart

Section Description # of Screws Removed

5.3 Preparing the Computer for 
Disassembly

Battery 0

5.4 Hard Drive 3 loosened to remove the 
hard drive cover
2 to remove each hard drive
4 to disassemble each 
hard drive

5.5 Computer Feet 0

5.6 Memory Module 2 loosened to remove the 
memory/Mini PCI module 
compartment cover
2 loosened to release the 
memory shield

5.7 Mini PCI Communications 
Module

0

Å To prevent an unresponsive system and the display of a 
warning message, install only a Mini PCI device authorized 
for use in your computer by the governmental agency that 
regulates wireless devices in your country. If you install a 
device and then receive a warning message, remove the 
device to restore computer functionality. Then contact 
Customer Care.

5.8 RTC Battery 0

5.9 Optical Drive 1

5.10 Switch Cover 5
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Section Description # of Screws Removed

5.11 Keyboard Assembly Frame 2

5.12 LED Board 4

5.13 Keyboard 5

5.14 Display Assembly 6 to remove the display 
assembly
6 to remove the display bezel
4 to remove the display panel
4 to remove each display 
hinge
1 to remove the display 
inverter

5.15 Top Cover 25

5.16 System Board 8

5.17 Bluetooth Module 2

5.18 Modem Connector Cable 0

5.19 USB Board 0

5.20 Speakers 2

5.21 Heat Sink 4

5.22 Processor 0

5.23 Fan Assembly 5

5.24 PC Card Assembly 2

Disassembly Sequence Chart (Continued)
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5.3 Preparing the Computer for 
Disassembly
Before you begin any removal or installation procedures: 

1. Shut down the computer. If you are unsure whether the 
computer is off or in hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power cord.
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4. Remove the battery by following these steps:

a. Turn the computer upside down with the front toward you.

b. Slide the battery release latch 1 to the left. (The battery 
disengages from the computer.)

c. Lift the front edge of the battery 3 up and swing it back 
to remove it.

Removing the Battery

Reverse the above procedure to install the battery.

Battery Spare Part Number Information

8-cell, 4.4-hour battery 403808-001
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5.4 Hard Drive

1. Prepare the computer for disassembly (refer to Section 5.3).

Hard Drive Spare Part Number Information

For use with HP Pavilion dv8200 models

7200 rpm, 100-GB
5400 rpm, 80-GB

418579-001
418576-001

4200-rpm, 120-GB
4200-rpm, 100-GB
4200-rpm, 60-GB

418580-001
418577-001
418578-001

For use with HP Pavilion dv8000 models

7200 rpm, 100-GB
5400 rpm, 80-GB

405938-001
403803-001

4200-rpm, 120-GB
4200-rpm, 100-GB
4200-rpm, 60-GB

405939-001
403804-001
405937-001

Hard drive cover for use with HP Pavilion dv8200 
models

419327-001

✎ The hard drive cover used with HP Pavilion dv8000 models is 
included in the Plastics Kit, spare part number 403812-001.

✎ All hard drive spare part kits include a hard drive frame.
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2. Loosen the three black Phillips PM2.5×6.0 screws 1 that 
secure the hard drive cover to the computer.

3. Lift the rear edge of the hard drive cover 2 and swing it up 
and forward and remove it.

✎ The hard drive cover is included in the Plastics Kit, spare part 
number 403812-001.

Removing the Hard Drive Cover
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4. Remove the two silver Phillips PM2.5×6.0 hard drive 
retention screws 1 that secure each hard drive to the 
computer.

5. Slide the hard drive 2 away from the hard drive connector.

6. Remove the hard drive from the hard drive bay 3.

Removing the Hard Drive
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7. Remove the four Phillips PM3.0×4.0 hard drive frame 
screws 1 that secure the hard drive frame to the hard drive.

8. Lift the hard drive straight up 2 to remove if from the 
hard drive frame.

Removing the Hard Drive Frame

Reverse the above procedure to reassemble and install the 
hard drive.
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5.5 Computer Feet
The computer feet are adhesive-backed rubber pads. The feet are 
included in the Plastics Kit, spare part number 403812-001.

Replacing the Computer Feet

5.6 Memory Module

1. Prepare the computer for disassembly (refer to Section 5.3).

2. Position the computer with the rear panel toward you.

Memory Module Spare Part Number Information

1024 MB 403800-001

512 MB 403799-001

256 MB 407843-001
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3. Loosen the two black Phillips PM2.5×6.0 screws 1 that 
secure the memory/Mini PCI module compartment cover to 
the computer.

4. Lift the right side of the cover 2 and swing it up and to the 
left and remove it.

✎ The memory/Mini PCI module compartment cover is included 
in the Plastics Kit, spare part number 403812-001.

Removing the Memory/Mini PCI Module Compartment Cover
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5. Loosen the two Phillips PM2.5×4.0 screws 1 that secure the 
memory shield to the computer.

6. Lift the right side of the memory shield 2 and swing it to 
the left as far as it will go.

Releasing the Memory Shield
Maintenance and Service Guide 5–13



Removal and Replacement Procedures
7. Spread the retaining tabs 1 on each side of the memory 
module socket to release the memory module. (The edge 
of the module opposite the socket rises away from 
the computer.)

8. Slide the module away from the socket at an angle 2.

9. Remove the memory module.

✎ Memory modules are designed with a notch 3 to prevent 
incorrect installation into the memory module socket.

Removing the Memory Module

Reverse the above procedure to install a memory module.
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5.7 Mini PCI Communications Module

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini PCI module compartment cover 
(Section 5.6).

Mini PCI Communications Module

Spare Part Number Information

802.11a/b/g wireless local access network (WLAN) module for 
use in North America

403791-001

802.11a/b/g WLAN module for use in the rest of the world 403792-001

802.11b/g WLAN module for use in North America 392557-001

802.11b/g WLAN module for use in the rest of the world 392557-002
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✎ Before disconnecting the antenna cables, make note of which 
cable is attached to which antenna clip on the Mini PCI 
communications module.

3. Disconnect the auxiliary and main antenna cables 1 from 
the Mini PCI communications module.

4. Spread the two retaining tabs 2 on each side of the 
Mini PCI socket to release the Mini PCI communications 
module. (The edge of the module opposite the socket rises 
away from the computer.)

5. Remove the Mini PCI communications module by pulling 
the card away from the socket at a 45-degree angle 3.

✎ The Mini PCI communications module is designed with a 
notch 4 to prevent incorrect installation.

Removing a Mini PCI Communications Module

Reverse the above procedure to install a Mini PCI 
communications module.
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5.8 RTC Battery

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini PCI module compartment cover 
(Section 5.6).

3. Remove the Mini PCI communications module (Section 5.7).

RTC Battery Spare Part Number Information

RTC battery 403819-001
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4. Remove the RTC battery from the socket on the 
system board.

Removing the RTC Battery

Reverse the above procedure to install an RTC battery.
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Removal and Replacement Procedures
5.9 Optical Drive

1. Prepare the computer for disassembly (Section 5.3).

2. Position the computer with the left side toward you.

Optical Drive Spare Part Number Information

DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe
DVD±RW and CD-RW Double-Layer Combo Drive
DVD/CD-RW Combo Drive

403807-001

403806-001
403805-001

DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe and Hitachi-LG Data Storage
DVD±RW and CD-RW Double-Layer Combo Drive with 
Hitachi-LG Data Storage
DVD/CD-RW Combo Drive with Hitachi-LG Data Storage

417621-001

417620-001

417619-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 
with LightScribe
DVD±RW and CD-RW Super Multi Combo Drive with 
LightScribe
DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

430862-001

430186-001

430861-001
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Removal and Replacement Procedures
3. Remove the Phillips PM2.5×13.0 screw 1 that secures the 
optical drive to the computer.

4. Insert a thin tool, such as an unbent paper clip 2, into 
the media tray release hole and release the media tray.

5. Use the media tray to slide the optical drive out of the 
computer 3.

6. Remove the optical drive.

Removing the Optical Drive

Reverse the above procedure to install an optical drive.
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Removal and Replacement Procedures
5.10 Switch Cover

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the two Phillips PM2.5×13.0 screws 1 and the three 
Phillips PM2.5×4.0 screws 2 that secure the switch cover to 
the computer.

Removing the Switch Cover Screws

Switch Cover Spare Part Number Information

Switch cover (includes LED board and LED board cable) 403817-001
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Removal and Replacement Procedures
3. Turn the computer display-side up with the front toward you.

4. Open the computer as far as possible.

5. Insert a flat-bladed screwdriver under the display hinge cover 
sections 1 of the switch cover.

6. Lift the switch cover until the left and right sides 2 of the 
switch cover disengage from the computer.

7. Remove the switch cover.

Removing the Switch Cover

Reverse the above procedure to install the switch cover.
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Removal and Replacement Procedures
5.11 Keyboard Assembly Frame

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini PCI module compartment cover 
(Section 5.6).

3. Remove the switch cover (Section 5.10).

4. Turn the computer upside down with the front toward you.

5. Remove the Phillips PM2.5×13.0 screw 1 in the 
memory/Mini PCI module compartment that secures the 
keyboard assembly frame to the computer.

6. Remove the silver Phillips PM2.5×6.0 screw 2 in the battery 
bay that secures the keyboard assembly frame to the 
computer.

Removing the Keyboard Assembly Frame Screws

Keyboard Assembly Frame Spare Part Number Information

Keyboard assembly frame 403818-001
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Removal and Replacement Procedures
7. Turn the computer display-side up with the front toward you.

8. Open the computer as far as possible.

9. Lift and hold the rear edge of the keyboard until the LED 
board cable connector is accessible.

Releasing the Keyboard Assembly Frame
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Removal and Replacement Procedures
10. Release the zero insertion force (ZIF) connector 1 to which 
the LED board cable is connected and disconnect the 
cable 2.

Releasing the Keyboard Assembly Frame
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Removal and Replacement Procedures
11. Swing the keyboard assembly frame 1 forward until the 
assembly rests on the palm rest.

12. Release the ZIF connector to which the keyboard cable 2 is 
attached and disconnect the keyboard cable 3.

13. Remove the keyboard assembly frame.

Removing the Keyboard Assembly Frame

Reverse the above procedure to install the keyboard assembly 
frame.
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Removal and Replacement Procedures
5.12 LED Board

1. Prepare the computer for disassembly (Section 5.3) and then 
remove the following components:

a. Memory/Mini PCI module compartment cover
(Section 5.6)

b. Switch cover (Section 5.10)

c. Keyboard assembly frame (Section 5.11)

2. Turn the keyboard assembly frame upside down with the 
LED board toward you.

LED Board Spare Part Number Information

For use with HP Pavilion dv8200 models
For use with HP Pavilion dv8000 models

417033-001
403833-001
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Removal and Replacement Procedures
3. Remove the four Phillips PM2.5×4.0 screws 1 that secure the 
LED board to the keyboard frame.

4. Remove the LED board 2.

Removing the LED Board

Reverse the above procedure to install the LED board.
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Removal and Replacement Procedures
5.13 Keyboard

1. Prepare the computer for disassembly (Section 5.3) and then 
remove the following components:

a. Memory/Mini PCI module compartment cover
(Section 5.6)

b. Switch cover (Section 5.10)

c. Keyboard assembly frame (Section 5.11)

2. Turn the keyboard assembly frame upside down with the 
LED board toward you.

Keyboard Spare Part Number Information

For use in:

France
French Canada
Germany
Italy
Norway

403809-051
403809-121
403809-041
403809-061
403809-091

Spain
Sweden and Finland
United Kingdom
United States

403809-071
403809-101
403809-031
403809-001
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Removal and Replacement Procedures
3. Remove the five Phillips PM2.5×4.0 screws 1 that secure the 
keyboard to the keyboard frame.

4. Remove the keyboard 2.

Removing the Keyboard

Reverse the above procedure to install the keyboard.
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Removal and Replacement Procedures
5.14 Display Assembly

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini PCI module compartment cover 
(Section 5.6).

✎ Before disconnecting the antenna cables, make note of which 
cable is attached to which antenna clip on the Mini PCI 
communications module.

Display Assembly Spare Part Number Information

17-inch, WSXGA+, TFT, single-lamp with BrightView
17-inch, WXGA+, TFT, single-lamp with BrightView

403797-001
403796-001
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Removal and Replacement Procedures
3. Disconnect the auxiliary and main antenna cables from the 
Mini PCI communications module.

Disconnecting the Wireless Antenna Cables
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Removal and Replacement Procedures
4. Remove the switch cover (Section 5.10).

5. Remove the keyboard assembly frame (Section 5.11).

6. Disconnect the display cable 1 from the system board.

7. Remove the wireless antenna cables from the clips 2 in the 
top cover.

Disconnecting the Display and Wireless Antenna Cables
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Removal and Replacement Procedures
Ä
CAUTION: Support the display assembly when removing the following 
screws. Failure to support the display assembly can result in damage to 
the display assembly and other computer components.

8. Remove the the silver Phillips PM2.5×6.0 screw 1 and the 
five Phillips PM2.5×9.0 screws 2 that secure the display 
assembly to the computer.

9. Lift the display assembly straight up and remove it 3.

Removing the Display Assembly
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Removal and Replacement Procedures
Display Assembly Subcomponent

Spare Part Number Information

Display Plastics Kits
For use with dual-lamp displays
For use with single-lamp displays
Includes:

■ Display bezel

■ Display enclosure

■ Display release latch actuator and hooks (not illustrated)

412269-001
403881-001

Display Hinge Kits
For use with dual-lamp displays
For use with single-lamp displays

412270-001
403884-001

Display inverter boards
For use with dual-lamp displays
For use with single-lamp displays

412268-001
403831-001

Display Panel Kits (include display panel cable)
17-inch, WSXGA+,TFT, single-lamp with BrightView
17-inch, WXGA+,TFT, single-lamp with BrightView

417617-001
417616-001

Wireless Antenna Kit (includes cable and transceivers) 403882-001

Display Cable Kits (not illustrated)
For use with dual-lamp displays
For use with single-lamp displays

412271-001
403885-001

Display Label Kit (not illustrated) 403887-001

Display Screw Kit (not illustrated), includes:

■ Phillips PM2.5×7.0 screws

■ Phillips PM2.5×5.0 screws

■ Rubber screw covers

403886-001

Pad Kit (not illustrated), includes rubber screw covers 403815-001
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Removal and Replacement Procedures
10. Remove the six rubber screw covers 1 and 2 and the 
six Phillips PM2.5×7.0 screws 3 that secure the display bezel 
to the display assembly.

✎ The four rubber screw covers 1 on the top edge of the display 
bezel are larger than the two rubber screw covers 2 on the 
bottom edge of the bezel.

Removing the Display Bezel Screws
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Removal and Replacement Procedures
11. Flex the inside edges of the left and right sides 1 and the 
top and bottom sides 2 of the display bezel until the bezel 
disengages from the display assembly.

12. Remove the display bezel 3.

Removing the Display Bezel
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Removal and Replacement Procedures
13. Disconnect the following cables:

1 Display panel cable

2 Light sensor cable

3 Display inverter cable

Disconnecting the Display Panel Cables
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Removal and Replacement Procedures
14. Remove the two Phillips PM2.5×4.0 screws 1 and the 
two Phillips PM2.5×7.0 screws 2 that secure the display 
panel to the display enclosure.

15. Remove the display panel 3.

Removing the Display Panel

Display Assembly Subcomponents

Spare Part Number Information

Display Panel Kits (include display panel cable)
17-inch, WSXGA+,TFT, single-lamp with BrightView
17-inch, WXGA+,TFT, single-lamp with BrightView

417617-001
417616-001
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Removal and Replacement Procedures
16. Remove the four Phillips PM2.0×4.0 screws 1 that secure 
each display hinge to the display panel.

17. Remove the display hinges 2.

Removing the Display Hinges

Display Assembly Subcomponents

Spare Part Number Information

Display Hinge Kits
For use with dual-lamp displays
For use with single-lamp displays

412270-001
403884-001
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Removal and Replacement Procedures
18. Remove the Phillips PM2.0×4.0 screw 1 that secures the 
display inverter board to the display enclosure.

19. Swing the top edge of the board 2 up and forward and 
remove it.

Removing the Display Inverter Board

Display Assembly Subcomponents

Spare Part Number Information

Display inverter boards
For use with dual-lamp displays
For use with single-lamp displays

412268-001
403831-001
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Removal and Replacement Procedures
20. Release the retention tabs 1 built in to the display enclosure 
lining that secure the wireless antenna cables to the display 
enclosure.

21. Detach the wireless antenna transceivers 2 from the display 
enclosure.

22. Remove the wireless antenna transceivers and cables 3.

Removing the Wireless Antenna Transceivers and Cables

Reverse the above procedure to reassemble and install the 
display assembly.

Display Assembly Subcomponents

Spare Part Number Information

Wireless Antenna Kit (includes cable and transceivers) 403882-001
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Removal and Replacement Procedures
5.15 Top Cover

1. Prepare the computer for disassembly (Section 5.3) and then 
remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

Top Cover Spare Part Number Information

Top cover (includes TouchPad) 403822-001
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Removal and Replacement Procedures
2. Release the ZIF connector to which the TouchPad cable 1 is 
connected and disconnect the TouchPad cable 2 from the 
system board.

✎ The TouchPad cable is included in the Cable Kit, spare part 
number 403814-001.

Disconnecting the TouchPad Cable

3. Turn the computer upside down with the front toward you.
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Removal and Replacement Procedures
4. Remove the two Phillips PM2.5×4.0 screws 1 and 
three silver Phillips PM2.5×6.0 screws 2 that secure the top 
cover to the computer.

Removing the Top Cover Screws, Part 1
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Removal and Replacement Procedures
5. Remove the five Phillips PM2.5×13.0 screws that secure the 
top cover to the computer.

Removing the Top Cover Screws, Part 2
5–46 Maintenance and Service Guide



Removal and Replacement Procedures
6. Turn the computer right-side up with the front toward you.

7. Remove the nine silver Phillips PM2.5×6.0 screws that secure 
the top cover to the computer.

Removing the Top Cover Screws, Part 3
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Removal and Replacement Procedures
8. Remove the six Phillips PM2.5×13.0 screws that secure the 
top cover to the computer.

Removing the Top Cover Screws, Part 4
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Removal and Replacement Procedures
9. Lift up the rear edge of the top cover 1 until it disengages 
from the base enclosure.

10. Lift the top cover 2 straight up and remove it.

Removing the Top Cover

Reverse the above procedure to install the top cover.
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Removal and Replacement Procedures
5.16 System Board

✎ When replacing the system board, ensure that the following 
components are removed from the defective system board and 
installed on the replacement system board:
■ Memory modules (Section 5.6)
■ Mini PCI communications module (Section 5.7)
■ RTC battery (Section 5.8)
■ Speaker (Section 5.20)
■ Heat sink (Section 5.21)
■ Processor (Section 5.22)
■ Fan assembly (Section 5.23)
■ PC Card assembly (Section 5.24)

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

System Board Spare Part Number Information

For use with HP Pavilion dv8200 models
For use with HP Pavilion dv8000 movels

417029-001
403790-001
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Removal and Replacement Procedures
2. Press in on the ExpressCard slot bezel 1 to release it.

3. Remove the ExpressCard slot bezel 2.

✎ The ExpressCard slot bezel is included in the Plastics Kit, 
spare part number 403812-001.

Removing the ExpressCard Slot Bezel
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Removal and Replacement Procedures
4. Remove the two silver Phillips PM2.5×6.0 screws 1 that 
secure the display hinge support bracket to the computer.

5. Remove the display hinge support bracket 2.

✎ The display hinge support bracket is included in the 
Plastics Kit, spare part number 403816-001.

Removing the Display Hinge Support Bracket
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Removal and Replacement Procedures
6. Remove the following screws:

1 One Phillips PM2.5×9.0 screw that secures the system 
board to the base enclosure

2 Four silver Phillips PM2.5×6.0 screws that secure the 
system board to the base enclosure

3 One Phillips PM2.5×4.0 screw that secures the connector 
board to the base enclosure

7. Remove the ExpressCard assembly 4.

✎ The ExpressCard assembly is available using spare part 
number 403838-001.

Removing the System Board Screws
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Removal and Replacement Procedures
8. Disconnect the following cables from the system board:

1 Modem cable

2 Bluetooth module cable

3 USB board cable

Disconnecting the Modem, Bluetooth Module, and 
USB Board Cables
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Removal and Replacement Procedures
9. Lift the right side of the system board 1 until the right side 
of the board is clear of the base enclosure.

10. Make sure the PC Card eject button 2 is depressed and clears 
the base enclosure.

11. Slide the system board 3 to the right at an angle and 
remove it.

Removing the System Board
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Removal and Replacement Procedures
12. Remove the optical drive connector board from the system 
board.

✎ The optical drive connector board is available using spare part 
numbers 403829-002 (for use with HP Pavilion dv8000 
models) and 417031-001 (for use with HP Pavilion dv8200 
models).

Removing the Optical Drive Connector Board

Reverse the above procedures to install the system board.
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Removal and Replacement Procedures
5.17 Bluetooth Module

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

Bluetooth Module Spare Part Number Information

Bluetooth module (includes Bluetooth module cable) 397922-001
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Removal and Replacement Procedures
2. Remove the two Phillips PM2.0×4.0 screws 1 that secure 
the Bluetooth module to the base enclosure

3. Remove the Bluetooth module from the base enclosure 2.

4. Disconnect the Bluetooth module cable 3 from the 
Bluetooth module.

Removing the Bluetooth Module
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Removal and Replacement Procedures
5. Slide and hold the battery release latch acuator 1 to the right.

6. Slide the Bluetooth module cable 2 through the hole in the 
battery release latch actuator 3 and the clips in the base 
enclosure.

7. Remove the Bluetooth module cable 4 from the clip in 
the base enclosure.

✎ The Bluetooth module cable is included with the Bluetooth 
module and is also available in the Cable Kit, spare part 
number 403814-001.

Removing the Bluetooth Module Cable

Reverse the above procedure to install the Bluetooth module.
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Removal and Replacement Procedures
5.18 Modem Connector Cable

✎ The modem connector cable is included in the Cable Kit, spare 
part number 403814-001.

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)
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Removal and Replacement Procedures
2. Remove the modem connector 1 from the clip 2 in the 
base enclosure.

3. Remove the modem connector cable from the routing 
channel 3 in the base enclosure.

Removing the Modem Connector Cable

Reverse the above procedure to install the modem connector 
cable.
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Removal and Replacement Procedures
5.19 USB Board

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.16)

USB Board Spare Part Number Information

USB boards (includes USB board and USB board cable)

For use with HP Pavilion dv8200 models
For use with HP Pavilion dv8000 models

417032-001
403830-001
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Removal and Replacement Procedures
2. Remove the USB cable from the routing clips 1 in the base 
enclosure.

3. Remove the USB board 2 from the base enclosure.

4. Disconnect the USB board cable 3 from the USB board.

✎ The USB board cable is included with the USB board and is 
also available in the Cable Kit, spare part number 403814-001.

Removing the USB Board

Reverse the above procedure to install a USB board.
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Removal and Replacement Procedures
5.20 Speakers

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.16)

Speaker Spare Part Number Information

Speakers 403825-001
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Removal and Replacement Procedures
2. Disconnect the speaker cable from the system board.

Disconnecting the Speaker Cable

3. Turn the system board upside down with the front 
toward you.
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Removal and Replacement Procedures
4. Remove the two silver Phillips PM2.5×6.0 screws 1 that 
secure the speaker to the system board.

5. Slide the speaker 2 forward until it clears the system board.

Removing the Speaker

Reverse the above procedure to install the speaker.
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Removal and Replacement Procedures
5.21 Heat Sink

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.16)

Heat Sink Spare Part Number Information

Heat sink (includes thermal paste) 403827-001
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Removal and Replacement Procedures
2. Turn the system board upside down with the expansion port 2 
toward you.

3. Remove the four silver Phillips PM2.5×6.0 screws 1 that 
secure the heat sink to the system board.

4. Remove the heat sink 2.

✎ Due to the adhesive quality of the thermal paste located 
between the heat sink and processor, it may be necessary to 
move the heat sink from side to side to detach the heat sink 
from the processor.

Removing the Heat Sink
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Removal and Replacement Procedures
✎ The thermal paste should be thoroughly cleaned from the 
surfaces of the heat sink 1 and processor 2 each time the heat 
sink is removed. Thermal paste should be reapplied to both 
surfaces before the heat sink is reinstalled. Thermal paste is 
included with all heat sink and processor spare part kits.

Replacing the Thermal Paste

Reverse the above procedure to install the heat sink.
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Removal and Replacement Procedures
5.22 Processor

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.16)

i. Heat sink (Section 5.21)

Processor Spare Part Number Information

AMD Turion 64 ML-44 (2.4-GHz)
AMD Turion 64 ML-40 (2.2-GHz)
AMD Turion 64 ML-40 (2.2-GHz)
AMD Turion 64 ML-37 (2.0-GHz)
AMD Turion 64 ML-34 (1.8-GHz)
AMD Turion 64 ML-32 (1.8-GHz)
AMD Turion 64 ML-30 (1.6-GHz)

410324-001
430499-001
393579-001
393578-001
417030-001
395744-001
395743-001

Mobile AMD Sempron 3300 (2.0-GHz)
Mobile AMD Sempron 3100 (1.8-GHz)

430860-001
430855-001

✎ All processor spare part kits include thermal paste.
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Removal and Replacement Procedures
2. Slide the tip of the processor socket release arm 1 forward 
until it clears the notch 2 on the processor socket.

3. Swing the processor socket release arm forward 3 as far as it 
will go.

4. Lift the processor straight up and remove it 4.

✎ The gold triangle 5 on the processor should be aligned in the 
front right corner when you install the processor.

Removing the Processor

Reverse the above procedure to install the processor.
Maintenance and Service Guide 5–71



Removal and Replacement Procedures
5.23 Fan Assembly

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.16)

i. Heat sink (Section 5.21)

Fan Assembly Spare Part Number Information

Fan assembly 403826-001
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Removal and Replacement Procedures
2. Disconnect the fan cable 1 and the power connector cable 2 
from the system board.

3. Remove the following screws:

3 One Phillips PM2.5×4.0 screw that secures the expansion 
port bracket and fan assembly to the system board

4 Two slotted M1.5×9.0 screws on each side of the 
expansion port 2 connector that secure the expansion port 
bracket and fan assembly to the system board

5 Two Phillips PM2.5×7.0 screws on each side of the 
external monitor connector that secure the fan assembly to 
the system board

Removing the Fan Assembly Screws
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Removal and Replacement Procedures
4. Slide the expansion port 2 bracket 1 away from the system 
board.

5. Remove the fan assembly 2.

Removing the Fan Assembly
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Removal and Replacement Procedures
✎ If necessary, perform the following steps to remove the power 
connector cable from the fan assembly.

✎ The power connector cable is included in the Cable Kit, spare 
part number 403814-001.

6. Turn the fan assembly upside down with the power connector 
toward you.

7. Remove the power connector cable 1 from the routing 
channel on the fan assembly.

8. Remove the power connector 2 from the clip in the fan 
assembly.

Removing the Power Connector Cable

Reverse the above procedure to install the power connector cable 
and fan assembly.
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Removal and Replacement Procedures
5.24 PC Card Assembly

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly frame (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.16)

PC Card Assembly Spare Part Number Information

PC Card assembly 403835-001
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Removal and Replacement Procedures
2. Turn the system board upside down with the audio jacks, 
USB ports, and external monitor port toward you.

3. Remove the two Phillips PM2.0×4.0 screws that secure the 
PC Card assembly to the system board.

Removing the PC Card Assembly Screws
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Removal and Replacement Procedures
4. Turn the system board right-side up with the audio jacks, 
USB ports, and external monitor port toward you.

5. Disengage the hooks 1 on the PC Card assembly from the 
slots 2 on the PC Card connector and remove the PC Card 
assembly 3 from the system board.

Removing the PC Card Assembly

Reverse the above procedures to install the PC Card assembly.
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6
Specifications

This chapter provides physical and performance specifications.

Table 6-1

Computer

Dimensions Metric U.S.

Height
Front
Rear
Width
Depth

3.76 cm
4.62 cm
39.68 cm
28.19 cm

1.48 in
1.82 in
15.62 in
11.10 in

Weight
With 17.0-inch display, optical 
drive and 8-cell battery

3.62 kg 7.98 lbs

Input Power

Operating voltage
Operating current

18.5 V dc to 19.0 V dc
4.74 A or 4.9 A

Temperature

Operating
Nonoperating

10°C to 35°C
-20°C to 60°C

50°F to 95°F
-4°F to 140°F
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Specifications
Relative humidity (noncondensing)

Operating
Nonoperating

10% to 90%
5% to 95%

10% to 90%
5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia)
Nonoperating (14.7 to 4.4 psia)

-15 m to 3,048 m
-15 m to 12,192 m

-50 ft to 10,000 ft
-50 ft to 40,000 ft

Shock

Operating
Nonoperating

125 g, 2 ms, half-sine
200 g, 2 ms, half-sine

Random Vibration

Operating

Nonoperating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 
0.25 oct/min sweep rate
1.50 g zero-to-peak, 10 Hz to 500 Hz, 
0.5 oct/min sweep rate

✎ Applicable product safety standards specify thermal limits for plastic 
surfaces. The computer operates well within this range of temperatures.

Table 6-1

Computer (Continued)
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Specifications
Table 6-2

17.0-inch, WSXGA+, BrightView Display

Dimensions

Height
Width
Diagonal

23.00 cm
36.80 cm
43.40 cm

9.06 in
14.49 in
17.09 in

Number of colors Up to 16.8 million

Contrast ratio 200:1

Brightness 180 nits typical

Pixel resolution

Pitch
Format
Configuration

0.197 × 0.197 mm
1680 × 1050
RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4 W

Viewing angle +/-65° horizontal, +50° vertical typical
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Specifications
Table 6-3

17.0-inch, WXGA+, BrightView Display

Dimensions

Height
Width
Diagonal

23.00 cm
36.80 cm
43.40 cm

9.06 in
14.49 in
17.09 in

Number of colors Up to 16.8 million

Contrast ratio 200:1

Brightness 180 nits typical

Pixel resolution

Pitch
Format
Configuration

0.259 × 0.259 mm
1280 × 800
RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4 W

Viewing angle +/-40° horizontal, +20/-40° vertical 
typical
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Specifications
Table 6-4

Hard Drives

100-GB* 80-GB* 80-GB*

Dimensions

Height
Width
Weight

9.5 mm
70 mm
102 g

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

Interface type ATA-5 ATA-5 ATA-5

Transfer rate

Synchronous (maximum)
Security

100 MB/sec
ATA security

100 MB/sec
ATA security

100 MB/sec
ATA security

Seek times (typical read, including setting)

Single track
Average
Maximum

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

Logical blocks† 195,364,233 156,301,488 156,301,488

Disc rotational speed 4200 rpm 5400 rpm 4200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

✎ Certain restrictions and exclusions apply. Consult Customer Care 
for details.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual 
accessible capacity is less.
†Actual drive specifications may differ slightly.
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Specifications
60-GB* 60-GB* 40-GB*

Dimensions

Height
Width
Weight

9.5 mm
70 mm
102 g

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

Interface type ATA-5 ATA-5 ATA-5

Transfer rate

Synchronous (maximum)
Security

100 MB/sec
ATA security

100 MB/sec
ATA security

100 MB/sec
ATA security

Seek times (typical read, including setting)

Single track
Average
Maximum

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

Logical blocks† 117,210,240 117,210,240 78,140,160

Disc rotational speed 5400 rpm 4200 rpm 4200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

✎ Certain restrictions and exclusions apply. Consult Customer Care 
for details.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual 
accessible capacity is less.
†Actual drive specifications may differ slightly.

Table 6-4

Hard Drives (Continued)
6–6 Maintenance and Service Guide



Specifications
Table 6-5

Primary 8-cell, Li-Ion Battery

Dimensions

Height
Width
Depth
Weight

2.00 cm
9.40 cm
13.40 cm
0.34 kg

0.79 in
3.70 in
5.28 in
0.75 lb

Energy

Voltage
Amp-hour capacity
Watt-hour capacity

11.1 V
4.4 Ah
48 Wh

Temperature

Operating
Nonoperating

5°C to 45°C
0°C to 60°C

41°F to 113°F
32°F to 140°F
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Specifications
Table 6-6

DVD/CD-RW Combo Drive

Applicable disc Read:
DVD-R, DVD-RW, DVD-ROM (DVD-5, 
DVD-9, DVD-10, DVD-18), CD-ROM 
(Mode 1 and 2) CD Digital Audio, 
CD-XA ready (Mode 2, Form 1 and 
2), CD-I ready (Mode 2, Form 1 and 
2), CD-R, CD-RW, Photo CD (single 
and multisession), and CD-Bridge

Write:
CD-R and CD-RW

Center hole 
diameter

1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD media DVD media

Random
Full stroke

< 110 ms
< 210 ms

< 130 ms
< 225 ms

Audio output 
level

Line-out, 0.7 V rms

Cache buffer 2 MB

Data transfer rate

CD-R (24X)
CD-RW (10X)
CD-ROM (24X)
DVD (8X)
Multiword DMA 
mode 2

3600 KB/s (150 KB/s at 1X CD rate)
1500 KB/s (150 KB/s at 1X CD rate)
3600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds
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Specifications
Table 6-7

DVD±RW and CD-RW Double-Layer Combo Drive

Applicable disc Read:
DVD-R, DVD-RW, DVD-ROM (DVD-5, 
DVD-9, DVD-10, DVD-18), CD-ROM 
(Mode 1 and 2), CD Digital Audio, 
CD-XA ready (Mode 2, Form 1 and 
2), CD-I ready (Mode 2, Form 1 and 
2), CD-R, CD-RW, Photo CD (single 
and multisession), CD-Bridge

Write:
CD-R and CD-RW
DVD-R and 
DVD-RW

Center hole 
diameter

1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random
Full stroke

< 175 ms
< 285 ms

< 230 ms
< 335 ms

Audio output 
level

Audio-out, 0.7 Vrms

Cache buffer 2 MB
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Specifications
Data transfer rate

CD-R (16X)
CD-RW (8X)
CD-ROM (24X)
DVD (8X)
DVD-R (4X)
DVD-RW (2X)
Multiword DMA 
mode 2

2,400 KB/s (150 KB/s at 1X CD rate)
1,200 KB/s (150 KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1,352 KB/s at 1X DVD rate)
5,400 KB/s (1,352 KB/s at 1X DVD rate)
2,700 KB/s (1,352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 6-7

DVD±RW and CD-RW Double-Layer Combo Drive (Continued)

Table 6-8

DVD±RW and CD-RW Double-Layer Combo Drive 

with LightScribe

Applicable disc Read:
DVD-R, DVD-RW, DVD-ROM (DVD-5, 
DVD-9, DVD-10, DVD-18), CD-ROM 
(Mode 1 and 2), CD Digital Audio, 
CD-XA ready (Mode 2, Form 1 and 
2), CD-I ready (Mode 2, Form 1 and 
2), CD-R, CD-RW, Photo CD (single 
and multisession), CD-Bridge

Write:
CD-R and CD-RW
DVD-R and 
DVD-RW

Center hole 
diameter

1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)
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Specifications
Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random
Full stroke

< 175 ms
< 285 ms

< 230 ms
< 335 ms

Audio output 
level

Audio-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

CD-R (16X)
CD-RW (8X)
CD-ROM (24X)
DVD (8X)
DVD-R (4X)
DVD-RW (2X)
Multiword DMA 
mode 2

2,400 KB/s (150 KB/s at 1X CD rate)
1,200 KB/s (150 KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1,352 KB/s at 1X DVD rate)
5,400 KB/s (1,352 KB/s at 1X DVD rate)
2,700 KB/s (1,352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 6-8

DVD±RW and CD-RW Double-Layer Combo Drive 

with LightScribe (Continued)
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Specifications
Table 6-9

System DMA

Hardware DMA System Function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
6–12 Maintenance and Service Guide



Specifications
Table 6-10

System Interrupts

Hardware IRQ System Function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard

IRQ2 Cascaded

IRQ3 USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio
Data Fax Modem with SmartCP 

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Realtek RTL8139 Family PCI fast Ethernet Controller
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Specifications
IRQ11 TI OHCI 1394 host controller
TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, 
IRQ10, or none.

✎ PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or 
IRQ15. Either the infrared or the serial port may assert IRQ3 or IRQ4.

Table 6-10

System Interrupts (Continued)
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Specifications
Table 6-11

System I/O Addresses

I/O Address (hex) System Function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2
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Specifications
I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 Joystick (decoded in ESS1688)

202 - 21F Unused

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

Table 6-11

System I/O Addresses (Continued)
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Specifications
I/O Address (hex) System Function (shipping configuration)

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)

Table 6-11

System I/O Addresses (Continued)
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Specifications
Table 6-12

System Memory Map

Size Memory Address System Function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 01000000-047FFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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A
 Screw Listing

This appendix provides specification and reference information 
for the screws and screw locks used in the computer. All screws 
listed in this appendix are available in the Computer Screw Kit, 
spare part number 403813-001, and the Display Screw Kit, spare 
part number 403886-001.

Phillips PM3.0×4.0 Screw Locations

Table A-1

Phillips PM3.0×4.0 Screw

Color Qty. Length Thread
Head 
Width

Black 4 4.0 mm 3.0 mm 4.5 mm

Where used:
4 screws that secure the hard drive frame to the hard drive (documented in 
Section 5.4)

mm
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Screw Listing
Black Phillips PM2.5×6.0 Screw Locations

Table A-2

Black Phillips PM2.5×6.0 Screw

Color Qty. Length Thread
Head 
Width

Black 5 6.0 mm 2.5 mm 5.0 mm

Where used:
1 Three screws that secure the hard drive cover to the computer (screws are 
captured on the cover by C clips; documented in Section 5.4)
2 Two screws that secure the memory/Mini PCI module compartment cover to 
the computer (screw is captured on the cover by C clips; documented in
Section 5.6)

mm
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Screw Listing
Silver Phillips PM2.5×6.0 Screw Locations

Table A-3

Silver Phillips PM2.5×6.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 29 6.0 mm 2.5 mm 4.5 mm

Where used:
4 screws that secure the hard drive to the computer (documented in
Section 5.4)

mm
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Screw Listing
Silver Phillips PM2.5×6.0 Screw Location

Table A-3

Silver Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 29 6.0 mm 2.5 mm 4.5 mm

Where used:
One screw that secures the keyboard assembly to the computer (documented in 
Section 5.11)

mm
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Screw Listing
Silver Phillips PM2.5×6.0 Screw Location

Table A-3

Silver Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 29 6.0 mm 2.5 mm 4.5 mm

Where used:
One screw that secures the display assembly to the computer (documented in 
Section 5.14)

mm
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Screw Listing
Silver Phillips PM2.5×6.0 Screw Locations

Table A-3

Silver Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 29 6.0 mm 2.5 mm 4.5 mm

Where used:
3 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Silver Phillips PM2.5×6.0 Screw Locations

Table A-3

Silver Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 29 6.0 mm 2.5 mm 4.5 mm

Where used:
8 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Silver Phillips PM2.5×6.0 Screw Locations

Table A-3

Silver Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 29 6.0 mm 2.5 mm 4.5 mm

Where used:
2 screws that secure the base enclosure support bracket to the computer 
(documented in Section 5.16)

mm
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Screw Listing
Silver Phillips PM2.5×6.0 Screw Locations

Table A-3

Silver Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 29 6.0 mm 2.5 mm 4.5 mm

Where used:
4 screws that secure the system board to the computer (documented in
Section 5.16)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-3

Phillips PM2.5×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 29 6.0 mm 2.5 mm 4.5 mm

Where used:
2 screws that secure the speaker to the computer (documented in
Section 5.20)

mm
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Screw Listing
Silver Phillips PM2.5×6.0 Screw Locations

Table A-3

Silver Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 29 6.0 mm 2.5 mm 4.5 mm

Where used:
4 screws that secure the heat sink to the computer (documented in
Section 5.21)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Locations

Table A-4

Phillips PM2.5×4.0 Screw

Color Qty. Length Thread
Head 
Width

Black 20 4.0 mm 2.5 mm 4.5 mm

Where used:
2 screws that secure the memory shield to the computer (documented in
Section 5.6)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Locations

Table A-4

Phillips PM2.5×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 20 4.0 mm 2.5 mm 4.5 mm

Where used:
3 screws that secure the switch cover to the computer (documented in
Section 5.10)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Locations

Table A-4

Phillips PM2.5×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 20 4.0 mm 2.5 mm 4.5 mm

Where used:
1 Four screws that secure the LED board to the keyboard frame (documented 
in Section 5.12)
2 Five screws that secure the keyboard to the keyboard frame (documented in 
Section 5.13)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Locations

Table A-4

Phillips PM2.5×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 20 4.0 mm 2.5 mm 4.5 mm

Where used:
2 screws that secure the display panel to the display enclosure (documented in 
Section 5.14)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Locations

Table A-4

Phillips PM2.5×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 20 4.0 mm 2.5 mm 4.5 mm

Where used:
2 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Location

Table A-4

Phillips PM2.5×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 20 4.0 mm 2.5 mm 4.5 mm

Where used:
One screw that secures the connector board to the computer (documented in 
Section 5.16)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Location

Table A-4

Phillips PM2.5×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 20 4.0 mm 2.5 mm 4.5 mm

Where used:
One screw that secures the fan assembly and expansion port bracket to the 
system board (documented in Section 5.23)

mm
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Screw Listing
Phillips PM2.5×13.0 Screw Locations

Table A-5

Phillips PM2.5×13.0 Screw

Color Qty. Length Thread
Head 
Width

Black 15 13.0 mm 2.5 mm 4.5 mm

Where used:
1 One screw that secures the optical drive to the computer (documented in
Section 5.9)
2 Two screws that secure the switch cover to the computer (documented in
Section 5.10)

mm
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Screw Listing
Phillips PM2.5×13.0 Screw Location

Table A-5

Phillips PM2.5×13.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 13.0 mm 2.5 mm 4.5 mm

Where used:
One screw that secures the keyboard assembly to the computer (documented in
Section 5.11)

mm
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Screw Listing
Phillips PM2.5×13.0 Screw Locations

Table A-5

Phillips PM2.5×13.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 13.0 mm 2.5 mm 4.5 mm

Where used:
5 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Phillips PM2.5×13.0 Screw Locations

Table A-5

Phillips PM2.5×13.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 13.0 mm 2.5 mm 4.5 mm

Where used:
6 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Phillips PM2.5×9.0 Screw Locations

Table A-6

Phillips PM2.5×9.0 Screw

Color Qty. Length Thread
Head 
Width

Black 6 9.0 mm 2.5 mm 4.5 mm

Where used:
5 screws that secure the display assembly to the computer (documented in
Section 5.14)

mm
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Screw Listing
Phillips PM2.5×9.0 Screw Location

Table A-6

Phillips PM2.5×9.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 6 9.0 mm 2.5 mm 4.5 mm

Where used:
One screw that secures the system board to the computer (documented in
Section 5.16)

mm
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Screw Listing
Phillips PM2.5×7.0 Screw Locations

Table A-7

Phillips PM2.5×7.0 Screw

Color Qty. Length Thread
Head 
Width

Black 10 7.0 mm 2.5 mm 4.5 mm

Where used:
6 screws that secure the display bezel to the display assembly (documented in
Section 5.14)

mm
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Screw Listing
Phillips PM2.5×7.0 Screw Locations

Table A-7

Phillips PM2.5×7.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 10 7.0 mm 2.5 mm 4.5 mm

Where used:
2 screws that secure the display panel to the display enclosure (documented in
Section 5.14)

mm
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Screw Listing
Phillips PM2.5×7.0 Screw Locations

Table A-7

Phillips PM2.5×7.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 10 7.0 mm 2.5 mm 4.5 mm

Where used:
2 screws that secure the fan assembly to the system board (documented in
Section 5.23)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Locations

Table A-8

Phillips PM2.0×4.0 Screw

Color Qty. Length Thread
Head 
Width

Black 13 4.0 mm 2.0 mm 4.0 mm

Where used:
8 screws that secure the display hinges to the display panel (documented in
Section 5.14)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Location

Table A-8

Phillips PM2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 13 4.0 mm 2.0 mm 4.0 mm

Where used:
One screw that secures the display inverter to the display enclosure 
(documented in Section 5.14)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Locations

Table A-8

Phillips PM2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 13 4.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the Bluetooth module to the computer (documented in
Section 5.17)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Locations

Table A-8

Phillips PM2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 13 4.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the PC Card assembly to the system board (documented 
in Section 5.24)

mm
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Screw Listing
Slotted M1.5×9.0 Screw Locations

Table A-9

Slotted M1.5×9.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 9.0 mm 1.5 mm 4.0 mm

Where used:
2 screws that secure the fan assembly to the system board (documented in
Section 5.23)

mm
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Software Update

and Recovery

Updating Software
Updated versions of the software provided with your computer 
may be available on the HP Web site.

Most software and BIOS updates on the HP Web site are 
packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, 
which contains information regarding installing and 
troubleshooting the file.

To update the software:

1. Identify your computer model, product category, and series or 
family. Prepare for a system BIOS update by identifying the 
BIOS version currently installed on the computer.

If your computer is connected to a network, consult the 
network administrator before installing any software updates, 
especially system BIOS updates.

✎ The computer system BIOS is stored on the system ROM. The 
BIOS initializes the operating system, determines how the 
computer will interact with the hardware devices, and provides 
for data transfer among hardware devices, including the time 
and date.

2. Access the updates by visiting the HP Web site at 
http://www.hp.com.

3. Install the updates.
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Updating the BIOS
To determine whether available BIOS updates contain later BIOS 
versions than those currently installed on the computer, you need 
to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System 
BIOS) can be displayed by pressing fn+esc (if you are already in 
Microsoft® Windows®) or by opening the Setup Utility.

To use the Setup Utility for displaying BIOS information:

1. Open the Setup Utility by turning on or restarting the 
computer, and then pressing f10 while the “Press <F10> to 
enter Setup” message is displayed in the lower-left corner of 
the screen.

2. If the Setup Utility does not open with the system 
information displayed, use the arrow keys to select the 
Main menu.

When the Main menu is selected, BIOS and other system 
information is displayed.

3. To exit the Setup Utility, use the arrow keys to select Exit > 
Exit Discarding Changes, and then press enter.

Ä
CAUTION: To prevent damage to the computer or an unsuccessful 
installation, download and install a BIOS update only when the computer 
is connected to reliable external power using the AC adapter. Do not 
download or install a BIOS update while the computer is running on 
battery power, docked in an optional docking device, or connected to an 
optional power source. During the download and installation, follow these 
instructions:
■ Do not disconnect power from the computer by unplugging the power 

cord from the AC outlet.

■ Do not shut down the computer or initiate standby or hibernation.

■ Do not insert, remove, connect, or disconnect any device, cable, 
or cord.
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To download a BIOS update:

1. Access the page on the HP Web site that provides software 
for your computer:

Select Start > Help and Support, and then select the 
software and drivers update.

2. Follow the instructions on the screen to identify your 
computer and access the BIOS update you want to download.

3. At the download area:

a. Identify the BIOS update that is later than the BIOS 
version currently installed on your computer. Make a note 
of the date, name, or other identifier. You may need this 
information to locate the update later, after it has been 
downloaded to your hard drive.

b. Follow the instructions on the screen to download your 
selection to the hard drive.

Make a note of the path to the location on your hard drive 
where the BIOS update will be downloaded. You will need 
to access this path when you are ready to install the update.

✎ If you connect your computer to a network, consult the 
network administrator before installing any software updates, 
especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that 
are displayed on the screen after the download is complete. If no 
instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > All 
Programs > Accessories > Windows Explorer.

2. In the left pane of the Windows Explorer window:

a. Click My Computer and then your hard drive 
designation. The hard drive designation is typically Local 
Disk (C:).

b. Using the hard drive path you recorded earlier, open the 
folder on your hard drive that contains the update.
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Software Update and Recovery
3. Double-click the file that has an .exe extension (for example, 
filename.exe).

The BIOS installation begins.

4. Complete the installation by following the instructions on the 
screen.

✎ After a message on the screen reports a successful installation, 
you can delete the downloaded file from your hard drive.

Updating Software Programs and Drivers
To download and install software other than a BIOS update:

1. Access the page on the HP Web site that provides software 
for your computer:

Select Start > Help and Support, and then select the 
software and drivers update.

2. Follow the instructions on the screen to find the software you 
want to update.

3. At the download area, select the software you want to 
download and follow the instructions on the screen.

✎ Make a note of the path to the location on your hard drive 
where the software will be downloaded. You will need to 
access this path when you are ready to install the software.

4. When the download is complete, open Windows Explorer by 
selecting Start > All Programs > Accessories > Windows 
Explorer.

5. In the left pane of the Windows Explorer window:

a. Click My Computer and then your hard drive 
designation. The hard drive designation is typically Local 
Disk (C:).

b. Using the hard drive path you recorded earlier, open the 
folder on your hard drive that contains the update.
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6. Double-click the file that has an .exe extension (for example, 
filename.exe).

The installation begins.

7. Complete the installation by following the instructions on the 
screen.

✎ After a message on the screen reports a successful installation, 
you can delete the download package from your hard drive.

Recovering System Information
Tools provided by the operating system and PC Recovery 
software are designed to help you with the following tasks for 
safeguarding your information and restoring it in case of a system 
failure:

■ Back up your information regularly to protect your important 
system files.

■ Make a set of recovery discs (PC Recovery software feature). 
Recovery discs are used to start up (boot) your computer and 
restore the operating system and software programs to factory 
settings in case of system failure or instability.

■ Create system restore points (operating system feature). 
System restore points allow you to reverse undesirable 
changes to your computer by restoring the computer to an 
earlier state.

■ Recover a program or driver (PC Recovery software feature). 
This feature helps you reinstall a program or driver without 
performing a full system recovery.

■ Perform a full system recovery (PC Recovery software 
feature). With PC Recovery, you can recover your full factory 
image if you experience system failure or instability. PC 
Recovery works from a dedicated recovery partition on the 
hard drive or from recovery discs you create.
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Backing Up Your Information

When to Back Up
■ On a regularly scheduled basis.

✎ Set reminders to back up your information periodically.

■ Before the computer is repaired or restored.

■ Before you add or modify hardware or software.

Backup Suggestions
■ Create system restore points using Windows XP Professional 

System Restore feature.

■ Store personal files in the My Documents folder and back up 
these folders periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings in a window, toolbar, or menu bar 
by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your 
preferences.

To copy the screen and paste it into a Word document:

a. Display the screen.

b. Copy the screen:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. To paste the copied images into a document, open Word, 
and then select Edit > Paste.
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Using System Restore Points
When you back up your system, you are creating a system restore 
point. A system restore point allows you to save and name a 
snapshot of your hard drive at a specific point in time. You can 
then recover back to that point if you want to reverse subsequent 
changes made to your system.

✎ Recovering to an earlier restore point does not affect data files 
saved or e-mails created since the last restore point.

You also can create additional restore points to provide increased 
protection for your system files and settings.

When to Create Restore Points
■ Before you add or extensively modify software or hardware.

■ Periodically, whenever the system is performing optimally.

✎ If you revert to a restore point and then change your mind, you 
can reverse the restoration.

Create a System Restore Point
1. Select Start > Help and Support, and then click System 

Restore.

The System Restore window opens.

2. Click Create a restore point, and then click Next.

3. Follow the on-screen instructions.
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Restore to a Previous Date and Time
To revert to a restore point (created at a previous date and time), 
when the computer was functioning optimally:

1. Select Start > Help and Support, and then click System 
Restore.

The System Restore window opens.

2. Click Restore my computer to an earlier time, and then 
click Next.

3. Follow the on-screen instructions.

Creating Recovery Discs
PC Recovery Disc Creator creates a set of recovery CDs or DVDs 
for the computer. Use recovery discs to restore the operating 
system and software programs to factory settings, in case of 
system failure or instability.

✎ Handle these discs carefully and keep them in a safe place. The 
software allows the creation of only one set of recovery discs.

Note the following guidelines before creating recovery discs:

■ You will need high quality CD-R, DVD-R, or DVD+R media 
(purchased separately).

✎ DVD±RW/R and double-layer DVD±RW are not compatible 
with the PC Recovery Disc Creator software.

■ The computer must be connected to AC power during this 
process.

■ Only one set of recovery discs can be created per computer.
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■ Number each disc before inserting it into the computer 
optical drive.

■ If necessary, you can exit the program before you have 
finished creating the recovery discs. The next time you open 
PC Recovery Disc Creator, you will be prompted to continue 
the disc creation process.

To create a set of recovery discs:

1. Select Start > All Programs > System Recovery > 
PC Recovery Disc Creator.

The PC Recovery Disc Creator tool opens.

2. Click Next.

✎ If you are operating the computer on battery power, you will be 
prompted to connect to AC power before you can go to the next 
step.

3. Select the type of disc you want to use and click Next.

✎ The software examines the image and displays the number of 
blank discs needed to create your recovery discs.

4. Insert the first disc and follow the on-screen instructions to 
complete the creation of the recovery discs.
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Reinstalling Software Programs and Drivers
If a program or driver preinstalled at the factory is accidentally 
erased or is damaged, the Application and Driver Recovery tool 
allows you to reinstall it.

✎ Software not provided with this computer must be reinstalled 
from the disc provided by the manufacturer or downloaded 
from the manufacturer's Web site.

✎ Before reinstalling the program, be sure it is fully uninstalled.

The Application and Driver Recovery tool replaces corrupted 
system files and reinstalls deleted system files within the 
program.

■ In most cases, if the program you are reinstalling is still on 
your computer, the reinstallation process does not affect your 
personal settings.

■ In all cases, if a program has been deleted from your 
computer, the reinstallation process reinstalls the program or 
utility to the factory image but cannot restore your personal 
settings.

Reinstalling Preinstalled Programs and 
Drivers

1. Remove the program or driver:

✎ In some cases, drivers are not listed in the Add or Remove 
Programs list. If the driver is not listed, it does not need to be 
removed.

a. Select Start > Control Panel > Add or Remove 
Programs.

b. Click the program or driver you want to remove, and then 
click Change/Remove.
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2. Select Start > All Programs > System Recovery > 
Application and Driver Recovery.

The Application and Driver Recovery tool opens.

3. Select Application Installation or Driver Installation, and 
then click Next.

4. Follow the on-screen instructions to complete the program or 
driver recovery.

5. Restart the computer if prompted.

Reinstalling Programs from Discs
1. Insert the disc into the optical drive.

2. When the installation wizard opens, follow the installation 
instructions on the screen.

3. Restart the computer if prompted.

Performing a Recovery
PC Recovery software allows you to repair or restore the system 
if you experience system failure or instability. PC Recovery 
works from recovery discs that you create or from a dedicated 
recovery partition on the hard drive.

✎ Microsoft Windows XP has its own built-in repair features, 
such as System Restore and driver roll-back capabilities. If you 
have not already tried these features, try them before using 
PC Recovery.

✎ PC Recovery only recovers software that was preinstalled at 
the factory. Software not provided with this computer must be 
reinstalled from the disc provided by the manufacturer or 
downloaded from the manufacturer's Web site.
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Recovering from the Recovery Discs
To restore the system from the recovery discs:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart 
the computer.

3. Follow the on-screen instructions.

Recovering from the Partition on the 
Hard Drive
You can perform a recovery from the partition on the hard drive 
from either the Start button or f11.

To restore the system from the partition:

1. Access the PC Recovery tool:

❏ To access PC Recovery from the Start button, select 
Start > All Programs > System Recovery > 
PC Recovery.

❏ To access PC Recovery from f11, restart the computer and 
press f11 while the “Press <F11> for recovery” message is 
displayed on the screen.

The PC Recovery tool opens.

2. Select PC Recovery and click Next.

The computer restarts and the PC Recovery tool opens.

3. Click OK.

4. Follow the on-screen instructions to complete the system 
recovery.

If you want to perform a destructive recovery:

✎ A destructive recovery formats the hard drive and restores the 
computer to its factory state. Select this option only as a last 
resort.
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a. Click Advanced Options on the System Recovery screen.

b. Select Destructive Recovery and follow the on-screen 
instructions.

Deleting the Recovery Partition on the 
Hard Drive

The PC Recovery Advanced Options menu provides the option of 
deleting the recovery partition, which will increase space on the 
hard drive. Delete the recovery partition only if you have already 
created recovery discs.

Ä
CAUTION: After you create the recovery discs, you can increase space 
on the hard drive by deleting the recovery partition. However, doing this 
is not recommended. If you delete this partition, you will lose any 
information that is on the partition, including the PC Recovery software. 
Thereafter, you must use the recovery discs to access PC Recovery 
software.

To delete the recovery partition:

1. If you have not already created recovery discs, create 
them now.

2. Select Start > All Programs > System Recovery > 
PC Recovery.

The PC Recovery tool opens.

3. Select PC Recovery and click Next.

The computer restarts and the PC Recovery tools opens.

4. Click OK.

5. At the System Recovery screen, click Advanced Options.

6. Select Delete Recovery Partition (not recommended) and 
follow the on-screen instructions.
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Updating Reinstalled Software
After you perform a system recovery, connect to the Internet to 
update all reinstalled software.

To access update links for the operating system and other 
software provided on your computer:

» Select Start > Help and Support.

To update optional software, follow the instructions provided by 
the software manufacturer. Some programs include an update 
feature you can access from a Help button or menu within the 
program.
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Display Component Recycling

Å
WARNING: The backlight contains mercury. Caution should be 
exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this appendix can result in damage to 
display components. The only components intended for recycling 
purposes are the liquid crystal display (LCD) panel and the backlight. 
Careful handling should be exercised when removing these 
components.

✎ Materials Disposal
This HP product contains mercury in the display assembly 
backlight and may require special handling at end-of-life.

Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact 
your local authorities or visit the Electronic Industries Alliance 
(EIA) at http://www.eiae.org.
Maintenance and Service Guide C–1

http://www.eiae.org


Display Component Recycling
This appendix provides disassembly instructions for the display 
assembly. The display assembly must be disassembled to gain 
access to the backlight 1 and the LCD panel 2.

✎ Disassembly procedures differ from one display assembly to 
another. The procedures provided in this appendix are general 
disassembly instructions. Specific details, such as screw sizes, 
quantities, and locations, and component shapes and sizes, can 
vary from one computer model to another.

Refer to Section 5.14, “Display Assembly,” for display assembly 
disassembly steps.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the 
display bezel to the display assembly.

Removing the Display Bezel Screw Covers and Screws
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2. Lift up and out on the left and right inside edges 1 and the 
top and bottom inside edges 2 of the display bezel until the 
bezel disengages from the display assembly.

3. Remove the display bezel 3.

Removing the Display Bezel
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4. Disconnect all LCD panel cables 1 from the display inverter 
and remove the inverter 2.

Removing the Display Inverter
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5. Remove all screws 1 that secure the LCD panel to the 
display enclosure.

6. Remove the LCD panel 2 from the display enclosure.

Removing the LCD Panel
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7. Turn the LCD panel upside down.

8. Remove all screws that secure the LCD panel frame to the 
LCD panel.

Removing the LCD Panel Frame Screws
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9. Use a sharp-edged tool to cut the tape 1 that secures the 
side of the LCD panel to the LCD panel frame.

10. Remove the LCD panel frame 2 from the display panel.

Removing the LCD Panel Frame
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11. Remove the screws 1 that secure the backlight cover to the 
LCD panel.

12. Lift the top edge of the backlight cover 2 and swing it 
forward.

13. Remove the backlight cover.

Removing the Backlight Cover
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14. Turn the LCD panel right-side up.

15. Remove the backlight cables 1 from the clip 2 in the 
LCD panel.

Releasing the Backlight Cables
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16. Turn the LCD panel upside down.

17. Remove the backlight frame from the LCD panel.

Removing the Backlight Frame
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Å
WARNING: The backlight contains mercury. Caution should be 
exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

18. Slide the backlight out of the backlight frame.

Removing the Backlight
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19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the LCD 
rear panel.

21. Release the LCD panel 3 from the LCD rear panel.

22. Release the tape 4 that secures the LCD panel to the LCD 
rear panel.

Releasing the LCD Panel
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23. Remove the LCD panel.

Removing the LCD Panel

24. Recycle the backlight and LCD panel.
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Connector Pin Assignments

Table D-1

Audio-Out (Headphone)

Pin Signal Pin Signal

1 Audio out, left channel 3 Ground

2 Audio out, right channel
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Connector Pin Assignments
Table D-2

Audio-In (Microphone)

Pin Signal Pin Signal

1 Audio signal in 3 Ground

2 Audio signal in

Table D-3

Universal Serial Bus

Pin Signal Pin Signal

1 +5 VDC 3 Data +

2 Data – 4 Ground
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Table D-4

External Monitor

Pin Signal Pin Signal

1 Red analog 9 +5 VDC

2 Green analog 10 Ground

3 Blue analog 11 Monitor detect

4 Not connected 12 DDC 2B data

5 Ground 13 Horizontal sync

6 Ground analog 14 Vertical sync

7 Ground analog 15 DDC 2B clock

8 Ground analog
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Connector Pin Assignments
Table D-5

RJ-45 (Network)

Pin Signal Pin Signal

1 Transmit + 5 Unused

2 Transmit – 6 Receive –

3 Receive + 7 Unused

4 Unused 8 Unused
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Table D-6

RJ-11 (Modem)

Pin Signal Pin Signal

1 Unused 4 Unused

2 Tip 5 Unused

3 Ring 6 Unused
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Connector Pin Assignments
Table D-7

S-Video-Out

Pin Signal Pin Signal

1 S-VHS color (C) signal 5 TV-CD

2 Composite video signal 6 S-VHS intensity ground

3 S-VHS intensity (Y) signal 7 Composite video ground

4 S-VHS color ground
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Power Cord Set Requirements

3-Conductor Power Cord Set
The wide range input feature of the computer permits it to operate 
from any line voltage from 100 to 120 or 220 to 240 volts AC.

The power cord set included with the computer meets the 
requirements for use in the country where the equipment 
is purchased.

Power cord sets for use in other countries must meet the 
requirements of the country where the computer is used.
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General Requirements
The requirements listed below are applicable to all countries.

■ The length of the power cord set must be at least 1.5 m 
(5.0 ft) and a maximum of 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable 
accredited agency responsible for evaluation in the 
country where the power cord set will be used.

■ The power cord sets must have a minimum current capacity 
of 10 amps and a nominal voltage rating of 125 or 250 V AC, 
as required by each country’s power system.

■ The appliance coupler must meet the mechanical 
configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of 
the computer.
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Country-Specific Requirements

3-Conductor Power Cord Set Requirements

Country/Region Accredited Agency Applicable Note Number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.
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Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

People’s Republic 
of China

CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

United Kingdom BSI 1

United States UL 2

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75 mm² conductor size. 
Power cord set fittings (appliance coupler and wall plug) must bear 
the certification mark of the agency responsible for evaluation in the country 
where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75 mm² conductor 
size. Power cord set fittings (appliance coupler and wall plug) must bear the 
certification mark of the agency responsible for evaluation in the country 
where it will be used.

3-Conductor Power Cord Set Requirements (Continued)

Country/Region Accredited Agency Applicable Note Number
E–4 Maintenance and Service Guide



Index

1394 port 1–11

A
all-in-one media cable, spare 

part number 3–18, 3–20
analog TV tuner, spare part 

number 3–18, 3–23
arrow keys 1–15
audio troubleshooting 2–21
audio Y-cable 2, spare part 

number 3–18, 3–20
audio-in jack

location 1–9
pin assignments D–2

audio-out jack
location 1–9
pin assignments D–1

B
base enclosure, spare part 

number 3–9, 3–22
battery

removal 5–6
spare part number 3–11, 

3–21, 5–6
specifications 6–7

battery bay 1–13, 1–22
battery light 1–7
battery release latch 1–22

Bluetooth module
removal 5–57
spare part number 3–9, 

3–20, 5–57
Bluetooth module cable

illustrated 3–15
removal 5–59

bottom components 1–22
Bracket Kit

contents 3–5
spare part number 3–5, 3–22

C
Cable Kit

components 3–15
spare part number 3–15, 

3–22
cables, service considerations 

4–2
caps lock key 1–15
CMOS clearing 1–4
components

bottom 1–22
front 1–6
keyboard 1–14
left-side 1–10, 1–12
right-side 1–8
top 1–16, 1–18, 1–21
Maintenance and Service Guide Index–1



Index
composite S-Video and audio 
cable, spare part number 
3–18, 3–23

computer feet
illustrated 3–14
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Computer Setup
Advanced Menu 2–5
Diagnostics Menu 2–4
File Menu 2–2
overview 2–1
Security Menu 2–3

computer specifications 6–1
connector pin assignments

audio-in D–2
audio-out D–1
external monitor D–3
RJ-11 D–5
RJ-45 D–4
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Universal Serial Bus (USB) 

D–2
connectors, service 

considerations 4–2

D
design overview 1–24
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Digital Media Slot light 1–11
disassembly sequence chart 

5–3
diskette drive

OS loading problems 2–19
precautions 4–3

display assembly
removal 5–31

spare part numbers 3–3, 
3–21, 5–31

specifications 6–3, 6–4
Display Cable Kit, spare part 

numbers 3–13, 3–24, 5–35
Display Hinge Kit

components 3–12, 5–35, 
5–40

spare part numbers 3–12, 
3–23, 3–24, 5–35, 5–40

display hinge support bracket
illustrated 3–5
removal 5–52

display inverter board
removal 5–41
spare part numbers 3–13, 

3–23, 3–24, 5–35, 5–41
Display Label Kit, spare part 

number 3–13, 3–23, 5–35
Display Panel Kit, spare part 

numbers 3–13, 3–25, 5–35, 
5–39

Display Plastics Kit
components 3–12, 5–35
spare part numbers 3–12, 

3–23, 3–24, 5–35
display release latch 1–7
Display Screw Kit, spare part 

number 3–13, 3–23, 5–35
display switch 1–16
drive light 1–7
drives, preventing damage 4–3
DVB-T TV tuner antenna 

adapter, spare part number 
3–18, 3–24
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DVB-T TV tuner antenna, 
spare part number 3–18, 
3–24

DVB-T TV tuner, spare part 
number 3–18, 3–24

DVD/CD-RW Combo Drive
precautions 4–3
removal 5–19
spare part numbers 3–5, 

3–17, 3–21, 3–25, 5–19
specifications 6–8

DVD±RW and CD-RW 
Combo Drive

precautions 4–3
removal 5–19
spare part numbers 3–17, 

5–19
specifications 6–9

DVD±RW and CD-RW 
Double-Layer Combo Drive

precautions 4–3
removal 5–19
spare part numbers 3–5, 

3–7, 3–17, 3–21, 3–25, 
3–26, 5–19

specifications 6–9, 6–10

E
electrostatic discharge 4–4, 

4–8
expansion port 2 1–11
expansion port 2 bracket, 

removal 5–74
expansion product

troubleshooting 2–14

ExpressCard assembly
removal 5–53
spare part number 3–7, 

3–22
ExpressCard slot 1–9
ExpressCard slot bezel

illustrated 3–14
removal 5–51

external monitor port
location 1–10
pin assignments D–3

F
f1 to f12 keys 1–15
fan assembly

removal 5–72
spare part number 3–7, 

3–22, 5–72
features 1–2
feet

illustrated 3–14
locations 5–11

flowcharts, troubleshooting
no audio 2–21, 2–22
no network/modem 

connection 2–26
no OS loading 2–15
no OS loading from 

diskette drive 2–19
no OS loading from hard 

drive 2–16, 2–17, 2–18
no OS loading from optical 

drive 2–20
no power 2–8, 2–10, 2–11
no video 2–12, 2–13
nonfunctioning device 2–23
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nonfunctioning docking 
device 2–14

nonfunctioning keyboard 
2–24

nonfunctioning pointing 
device 2–25

fn key 1–15
front components 1–6

G
grounding equipment and 

methods 4–7

H
hard drive

OS loading problems 2–16
precautions 4–3
removal 5–7
spare part numbers 3–9, 

3–16, 3–21, 3–23, 3–25, 
5–7

specifications 6–5
hard drive bay 1–23
hard drive cover

illustrated 3–14
removal 5–8
spare part number 3–9, 

3–25, 5–7
headphone jack, pin 

assignments D–1
headset, spare part number 

3–19, 3–20
heat sink

removal 5–67
spare part number 3–7, 

3–22, 5–67

I
I/O address specifications 

6–15
infrared blaster cable, spare 

part number 3–18, 3–24
infrared USB receiver, spare 

part number 3–18, 3–24
interrupt specifications 6–13

K
keyboard

removal 5–29
spare part numbers 3–3, 

3–21, 3–22, 5–29
troubleshooting 2–24

keyboard assembly frame
removal 5–23
spare part number 3–3, 

3–22, 5–23
keyboard components 1–14
keypad keys 1–15

L
LED board

removal 5–27
spare part numbers 3–3, 

3–23, 3–25, 5–27
left-side components 1–10, 

1–12

M
mass storage devices, spare 

part numbers 3–16
media cable, spare part number 

3–18, 3–20
memory map specifications 

6–18
Index–4 Maintenance and Service Guide



Index
memory module
removal 5–11
spare part numbers 3–11, 

3–21, 3–23, 5–11
memory shield, release 5–13
memory/Mini PCI module 

compartment cover
illustrated 3–14
location 1–23
removal 5–12

microphone jack, pin 
assignments D–2

Mini PCI communications 
module

removal 5–15
spare part numbers 3–11, 

3–20, 3–21
modem connector cable

illustrated 3–15
removal 5–60

modem jack
location 1–13
pin assignments D–5

modem module
troubleshooting 2–26

N
network jack

location 1–10
pin assignments D–4

network, troubleshooting 2–26
nonfunctioning device, 

troubleshooting 2–14, 2–23
num lock key 1–15

O
optical drive

location 1–9, 1–22
OS loading problems 2–20
precautions 4–3
removal 5–19
spare part numbers 3–5, 

3–7, 3–17, 5–19
specifications 6–8

optical drive connector board
removal 5–56
spare part numbers 3–7, 

3–22, 3–24

P
packing precautions 4–5
Pad Kit, spare part number 

3–13, 3–22, 5–35
password clearing 1–4
PC Card assembly

removal 5–76
spare part number 3–9, 

3–23, 5–76
PC Card eject button 1–11
PC Card slot 1–11
PC Card slot bezel, illustrated 

3–14
plastic parts 4–2
Plastics Kit

components 3–9, 3–14
spare part number 3–9, 

3–14, 3–22
pointing device, 

troubleshooting 2–25
power button 1–17
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power connector
locations 1–10
spare part numbers 3–18, 

3–24
power connector cable

illustrated 3–15
removal 5–75

power cord
set requirements E–2
spare part numbers 3–18, 

3–22
power light 1–7, 1–17
power management features 

1–5
power supply, spare part 

numbers 3–19, 3–22, 3–24
power, troubleshooting 2–8
precautions

DVD/CD-RW Combo 
Drive 4–3

DVD±RW and CD-RW 
Double-Layer Combo 
Drive 4–3

hard drive 4–3
optical drive 4–3

processor
removal 5–70
spare part numbers 3–7, 

3–20, 3–24, 3–26, 5–70

Q
Quick Launch calculator 

button 1–20

R
remote control, spare part 

number 3–18, 3–20
remote TV tuner, spare part 

number 3–19
removal/replacement

preliminaries 4–1
procedures 5–1

RF cable, spare part number 
3–19, 3–24

RF input adapter cable, spare 
part number 3–19, 3–23

right-side components 1–8
RJ-11 jack

location 1–13
pin assignments D–5

RJ-45 jack
location 1–10
pin assignments D–4

RTC battery
removal 5–17
spare part number 3–9, 

3–22, 5–17

S
Screw Kit

contents A–1
spare part numbers 3–13, 

3–19, 3–22, 3–23, 5–35, 
A–1

screw listing A–1
SD memory card, spare part 

numbers 3–11, 3–20, 3–23
security cable slot 1–13
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serial number 3–1, 5–2
service considerations 4–2
speakers

location 1–7
removal 5–64
spare part number 3–5, 

3–22, 5–64
specifications

battery 6–7
computer 6–1
display assembly 6–3, 6–4
DVD/CD-RW Combo 

Drive 6–8
DVD±RW and CD-RW 

Combo Drive 6–9
DVD±RW and CD-RW 

Double-Layer Combo 
Drive 6–9, 6–10

hard drive 6–5
I/O addresses 6–15
interrupts 6–13
memory map 6–18
optical drive 6–8
system DMA 6–12

static shielding materials 4–8
S-Video-out jack

location 1–10
pin assignments D–6

switch cover
removal 5–21
spare part number 3–3, 

3–22, 5–21
system board

removal 5–50

spare part number 5–50
spare part numbers 3–5, 

3–20, 3–24
system DMA 6–12
system memory map 6–18

T
tools required 4–1
top components 1–16, 1–18, 

1–21
top cover

removal 5–43
spare part number 3–5, 

3–22, 5–43
TouchPad cable

disconnection 5–44
illustrated 3–15

transporting precautions 4–5
troubleshooting

audio 2–21
Computer Setup 2–1
expansion product 2–14
flowcharts 2–6
keyboard 2–24
modem 2–26
network 2–26
nonfunctioning device 

2–14, 2–23
OS loading 2–15
overview 2–1
pointing device 2–25
power 2–8
video 2–12

TV tuner remote control, spare 
part number 3–19, 3–23
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U
Universal Serial Bus (USB) 

port
location 1–9, 1–11
pin assignments D–2

unknown password 1–4
USB board

removal 5–62
spare part numbers 3–7, 

3–23, 3–25, 5–62
USB board cable

illustrated 3–15
removal 5–63

USB digital drive, spare part 
number 3–17, 3–19, 3–20

USB travel mouse, spare part 
number 3–19, 3–20

V
vent, locations 1–13, 1–23
video troubleshooting 2–12
volume buttons 1–17

W
Windows applications key 

1–15
Windows logo key 1–15
wireless antenna

removal 5–42
spare part number 3–13, 

3–23, 5–35, 5–42
wireless button 1–17
wireless light 1–13, 1–16
workstation precautions 4–6
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